Contents

Introduction ................................................................................................................... 4
Support and Resources ................................................................................................ 4

Starting Your System .................................................................................................. 5
Logging on to Sage HRMS.......................................................................................... 5
Use the Initialization file .............................................................................................. 6

Setup Checklists ........................................................................................................ 8
Sage HRMS Setup Checklist .......................................................................................... 8
Time Off Setup Checklist ............................................................................................. 9
Sage HRMS Train Setup Checklist ................................................................................ 10
Payroll Setup Checklist ............................................................................................... 11

Navigating Sage HRMS ............................................................................................... 13
Using the Sage HRMS Desktop..................................................................................... 13
Hierarchy in the Navigation Pane ................................................................................ 14
The File Menu ................................................................................................................. 14
The Edit Menu ................................................................................................................ 15
The Help Menu .............................................................................................................. 15
The Employer Filter List ............................................................................................... 16
The Help Button ........................................................................................................... 17
Using Tabs ...................................................................................................................... 18
Selecting From a Drop-Down List Box ......................................................................... 18
Entering Text in a Text Box .......................................................................................... 18
To Enter a Date in a Text Box ...................................................................................... 19
Close and Resize pages ............................................................................................... 20
Access Context-Sensitive Help .................................................................................... 20
Accessing the Main Menu ............................................................................................ 20
Using the Tab Key ......................................................................................................... 21
Using the Edit Keys ....................................................................................................... 21
Keyboard Shortcuts ....................................................................................................... 22
Finding an Employee ................................................................................................... 22
Fields on the Employee Find ..................................................................................... 23
Find an Employee ........................................................................................................ 23
Navigating through a list of Employees on Detail Pages ......................................................... 24
Using Advanced Find ............................................................................................................. 24
   Fields on the Advanced Find ............................................................................................. 24
   Using the Advanced Find .................................................................................................. 25
Employee Information Bar ..................................................................................................... 25
Using the Advanced Find ....................................................................................................... 25
   Employee Information Bar ............................................................................................... 25
   Using the Quick Launch Toolbar ....................................................................................... 26
      Quick Launch toolbar buttons ....................................................................................... 26
Using the Organizer and Scheduler ....................................................................................... 27
   To Use the Organizer ........................................................................................................ 27
   Move Around in the Organizer ......................................................................................... 27
   Use the Organizer Toolbar ............................................................................................... 28
   Use the Organizer Lists ................................................................................................... 29
   Use the Scheduler ............................................................................................................ 33
   Repeat Items .................................................................................................................. 35
   Maintain the Day of the Week ......................................................................................... 36
   Move to Closest Date ...................................................................................................... 36
   Forward to Next Available Date .................................................................................... 36
   Backward to Last Available Date .................................................................................. 37
   Mark an Item as Complete .............................................................................................. 38

Setting Up Sage HRMS ........................................................................................................... 39
   Enterprise as a Time-Saver .............................................................................................. 39
   Enterprise as the Panoramic View .................................................................................. 40
Setting Up the Enterprise ....................................................................................................... 40
   Select the Enterprise Logo ............................................................................................. 41
   To Select a Logo ............................................................................................................. 41
   To Remove a Logo ......................................................................................................... 41
   To Set Up the Audit Trail ............................................................................................... 42
Setting Up Employers ........................................................................................................... 43
   If your system includes Payroll ...................................................................................... 44
   To Modify an Employer .................................................................................................. 44
   To Delete an Employer .................................................................................................. 45
Setting Up User Preferences .................................................................................................. 45
Setting Up Code Tables ........................................................................................................ 47
   Working with Sage HRMS Code Tables ....................................................................... 49
   To Copy Code Tables .................................................................................................... 49
Contents

To Add Codes ............................................................................................................................................. 49
To Edit Codes ............................................................................................................................................. 50
To Delete Codes .......................................................................................................................................... 50
To Add a Code from a Detail .................................................................................................................... 51
Setting Up Security ........................................................................................................................................ 51
  Security Concepts ....................................................................................................................................... 52
  Establish Access Rights .............................................................................................................................. 52
  Security Levels ............................................................................................................................................ 53
  Field Level Access ....................................................................................................................................... 58
  How Access Levels Work .......................................................................................................................... 62
  Set a Group’s Ad Hoc Reporting Security Level .................................................................................... 63
Changing a Password ........................................................................................................................................ 64
  Quick Launch Toolbar Security ................................................................................................................ 64
  To Set Up Quick Launch Toolbar Security .............................................................................................. 64
Introduction

This guide provides an overview for using Sage HRMS.

Support and Resources

Sage strives to provide you with the best help and support in the industry. If you have a question, we're here to help!

- **Help and documentation**: Many answers to common questions can be found in the help and documentation included with Sage HRMS and Sage Employee Self Service. Visit the [Sage HRMS product documentation website](http://SageHRMS.com) for a library of guides.

- **Sage University**: Learn pro tips for using Sage HRMS in online or classroom courses. Visit [http://SageU.com](http://SageU.com) and log on or create an account to register for training.

- **Sage City**: Visit [http://sagecity.na.sage.com](http://sagecity.na.sage.com) for help, guidance, documents, and downloads specific to Sage HRMS and modules.

- **Customer Support**: For additional articles and resources, visit [https://support.na.sage.com](https://support.na.sage.com) or contact Customer Support at 800-829-0170 (U.S. and Canada). Please have your Customer ID handy when contacting Customer Support.

- **Tax forms**: Because all printed forms have variations, Sage HRMS Payroll only supports forms printed by Sage Checks and Forms. Call Sage Checks and Forms at 800-617-3224 or order online at [www.SageChecks.com](http://www.SageChecks.com).
Starting Your System

After you install the system, you are ready to start Sage HRMS and begin to learn about and use the system’s features.

Logging on to Sage HRMS

When logging on to Sage HRMS, you can select sample data or live data. The sample data includes employees and scheduled tasks in the Organizer, which mimic how an actual company may use Sage HRMS. If you are new to Sage HRMS, the sample data allows you to familiarize yourself with entering data and using features without adversely affecting your company’s production (or live) data.

Note: Press Ctrl + U on the Logon page if you want to update system files before logging on to Sage HRMS.

When logging on to Sage HRMS, you must enter a user ID and password to access either database.

To Log On

1. From the Start menu, select All Programs > Sage > Sage HRMS Client > Sage HRMS Client.
2. The Logon page opens. You can log on in two different ways:
   - To log on as MASTER, clear the Windows Logon check box and enter the logon for the MASTER user.
   - To log on with Windows Authentication, select the Windows Logon check box and enter your Windows account user name and password. Be sure to include the domain in the Username field (for example, COMPANY\cbrown, where COMPANY is user cbrown’s domain).
3. Select to use sample or live data. If you also installed Sage HRMS Link, you can log on to Sage HRMS Link right from the logon page.
4. Click Logon to open the application.

Live data is your company’s production database, which contains employee information and other company data. Sage HRMS provides a default user name and password for you to log on for the first time. After logging on, change the login credentials and set up security according to your company’s requirements.
Use the Initialization file

Sage HRMS provides the initialization (ABRAWIN.INI) file to customize your Sage HRMS environment according to your needs. This feature provides additional capabilities for using Sage HRMS on Local Area Networks (LANs).

After installing Sage HRMS, you can use the ABRAWIN.INI file to specify any directory for the following items: live data, sample data, temp file directory, and export directory.

Photos (.jpg, .gif, or .bmp files) displayed on the Demographics page are, by default, stored in ...\Sage\SageHRMS\Server\Data\Photos. You can also use the ABRAWIN.INI file to provide a different storage location by entering the appropriate path.

If you are using a LAN, you can keep the Sage HRMS programs (executable files) on your local PC for fast access and then obtain information from a common server. By using the ABRAWIN.INI file, you can assign the required paths to locate the information.

Rebuilding System Files

When you first install Sage HRMS or start Sage HRMS, the system automatically initializes your system and rebuilds your system files for you. This ensures you can access the features that you are registered to use.

There might be times, such as with a power failure, when you need to rebuild your system files to ensure you can access your installed options.

Note: Press Ctrl + U on the Logon page if you want to rebuild system files before logging on to Sage HRMS.

1. From the navigation pane, select **Setup > System > Maintenance > Rebuild System Files**.
2. Click **Yes**. The process begins and requires no other action on your part. When the process is complete, you are returned to the log-in page.

Uninstalling Sage HRMS

**Warning!** If you set up the enterprise and added employers using live data, you should back up all the files located in the \DATA subdirectory of your Sage HRMS system. If necessary, you can restore the files and access the data after re-installing Sage HRMS.

To completely uninstall Sage HRMS, you must uninstall the clients and the server. If your system includes payroll, there are several payroll modules that will also be uninstalled.

To uninstall Sage HRMS, remove the following programs, in the order listed. You must have administrator privileges to uninstall.


**Note:** You can only use the Add/Remove Programs function to uninstall the Sage HRMS application. You cannot use setup.exe to uninstall.

1. Go to Add/Remove Programs.
2. Remove Sage HRMS Client. Note that when the client is uninstalled, all payroll modules are also removed.
3. Remove Sage HRMS Server.
Setup Checklists

Sage HRMS Setup Checklist

Before you begin using Sage HRMS you must complete several steps. These setup steps allow you to customize the system to meet your employer's requirements precisely.

1. **Set up the enterprise.** Consider the enterprise as the parent company of your organization. The enterprise contains the standards for your system. You can insert a logo and specify organization titles as you set up the enterprise.

2. **Set up the audit trail for the enterprise.** The Audit Trail gives you the ability to track changes made to the system databases. You can select the database files and fields to audit as well as choose to enable or disable the audit.

3. **Add employers.** Before you can set up an employer, you must add an employer to the system. You enter its name and address as you want them to appear on reports. You can also define the way your employer pays most of its employees, including frequency and units.

4. **Set up employers.** For each Sage HRMS module you use (HR, Time Off, Training, Payroll), you must define unique parameters for each employer you add to your system.

5. **Set up code tables.** Your system uses codes to manage and store information in files. These codes provide abbreviated and standard references to specific information. This step enables you to modify or add to those codes as you customize Sage HRMS to the way you do business.

6. **Set up benefits.** Sage HRMS uses the guidelines you define for employee benefits. This step allows you to easily manage even the most complex benefit plan, including your employer's insurance and savings plans as well as any rate tables used by the plans.

7. **Set up security.** The system provides an extensive, flexible, and easy-to-use security system to help you protect your data. During this final step in the setup procedure, you establish security limits and privileges for all system users. The security system breaks out functions by product, employer, activity, task, and step. When you set up security, you assemble users in security groups and establish passwords for each user.
**Time Off Setup Checklist**

Time Off uses the records in Sage HRMS to help you build your attendance tracking system so you can administer attendance benefits and track employee absences. After you set up your enterprise, employers, code tables, and security in Sage HRMS, you are ready to provide Time Off with the basic information necessary to start tracking and accruing employee absences and benefits.

You must complete several steps before you begin using Time Off.

1. **Set up the enterprise.** Consider the enterprise as the parent company of your organization. The enterprise contains the standards for your system. You can insert a logo and specify organization titles as you set up the enterprise.

2. **Set up the audit trail for the enterprise.** The Audit Trail gives you the ability to track changes made to the system databases. You can select the database files and fields to audit as well as choose to enable or disable the audit.

3. **Add employers.** Before you can set up an employer, you must add an employer to the system. You enter its name and address as you want them to appear on reports. You can also define the way your employer pays most of its employees, including frequency and units. After adding your employer, you can begin setting up the employer and your code tables. You must first set up your employer and codes in Sage HRMS.

4. **Set up an employer for Time Off.** For each Sage HRMS module you use (HR, Time Off, Training, Payroll), you must define unique parameters for each employer you add to your system.

5. **Set up code tables.** Your system uses codes to manage and store information in files. These codes provide abbreviated and standard references to specific information. This step enables you to modify or add to those codes as you customize the system to the way you do business.

6. **Set up security.** After setting up your employers and code tables, you are ready to set up security. The system provides an extensive, flexible, and easy-to-use security system to help you protect your data. During this final step in the setup procedure, you establish security limits and privileges for all system users. The security system breaks out functions by product, employer, activity, task, and step. When you set up security, you assemble users in security groups and establish passwords for each user.

7. **Set up attendance plans.** Attendance plans define types (vacation, sick leave, etc.), calculation methods, and other information required to track time off. Optionally, you can configure Time Off to use rules and data from Sage HRMS Payroll to calculate maximum available hours, maximum carryover hours, and total carryover hours. This approach ensures that Time Off calculations based on hours worked reflect actual hours as recorded in Sage HRMS Payroll.

After you complete these steps, you are ready to enroll employees into attendance plans. Use the Attendance Summary page to enroll each employee in an attendance plan, include year-to-date absence and attendance benefits information, enter the previous year’s carryover units and modify the information as needed. Time Off provides the procedures and utilities to assist you as you fulfill your employer’s attendance tracking requirements.
Sage HRMS Train Setup Checklist

These setup steps are a one-time procedure. After you complete these steps, you will be ready to begin using the Training module.

1. **Set up the enterprise.** Consider the enterprise the parent company of your organization. The enterprise contains the standards for your system. You can insert a logo and specify organization titles as you set up the enterprise. See Setting Up the Enterprise.

2. **Set up the audit trail for the enterprise.** The Audit Trail gives you the ability to track changes made to the system databases. You can select the database files and fields to audit as well as choose to enable or disable the audit. See Setting Up the Enterprise.

3. **Add an employer.** Before you can begin using the system, you must add an employer. You enter the employer’s name and address as you want them to appear on reports.

4. **Select a Training Employer.** If you have multiple employers in your system, decide whether you want to store all training information in a single employer, called the Training Employer, or whether you want to keep training information separate for your different employers.

5. **Set up code tables.** Training uses codes to manage and store information in files. For example, every course, certification, and program is assigned its own code to uniquely identify it. You can modify or add to the codes in Training to tailor the system to meet your needs.

6. **Set up security.** The system provides an extensive, flexible, and easy-to-use security system to help you protect your data. You can establish security limits and privileges for all system users. When you set up security, you assemble users in security groups and establish passwords for each user. See Setting Up Security.

7. **Define titles for the miscellaneous fields in Training.** Training provides miscellaneous fields for you to record information specific to your needs. You can define your own titles for these fields.
Payroll Setup Checklist

This checklist is designed to help you set up Sage HRMS Payroll. It lists the necessary order and steps to prepare your system for payroll processing. For details on any of these steps, refer to the in-product Help.

1. **Install Payroll and set up databases.** Create the system, payroll, and company databases; add the employer; do database setup, employer configuration, and employee configuration.

2. **Gather data from your present payroll system.** Collect lists and balances of items such as; your general ledger accounts including salary and wages payable, liability, and expense accounts; workers’ compensation codes and records; earnings and deductions, paid time off accruals, benefits, and so on; payroll tax information for all employees; and employee historical payroll data.

3. **Set up General Ledger.** Add the general ledger accounts you need for your payroll data, including the Salary and Wages Payable account, the Suspense account, and all the other expense and liability accounts you use to process payroll.

4. **Add bank information for payroll.** Use the Banks setup window to set up company bank accounts, payroll bank defaults, and printed check forms used in payroll processing.

5. **Set up default payroll options.** Enter the company’s default payroll processing information on the Payroll Setup Options window.

6. **Define Payroll and G/L integration.** Enter the information on each tab of the Payroll G/L Integration window in Payroll Setup to define how G/L transactions and journal entries specific to payroll should post with payroll processing.

7. **Set up optional fields (optional).** Use the Optional Fields window in Payroll Setup to define customization for the module. You can then use the Assign Optional Fields window to define which records and transactions should use them.

8. **Set up class codes (optional).** Use the Class Codes window in Payroll Setup to define payroll classes or levels that can then be assigned to employees.

9. **Set up earnings, deductions, and other pay factors.** Set up the pay factors that are paid, deducted, or otherwise used in calculating employees’ pay by completing all of the tabs in the Earning/Deduction Codes window.

10. **Set up workers’ compensation codes.** Enter the information in the Workers’ Compensation Codes setup window.

11. **Set up overtime schedules (optional).** Enter any applicable overtime schedules so that overtime pay rates can be coordinated by schedule on the Overtime Schedules setup window.

12. **Set up shift differential codes (optional).** Once the overtime schedules are set up, you can define the schedules for pay differential by work shifts on the Shift Differential Codes setup window.

13. **Set up work classification codes (optional).** Work classification codes can be assigned to employees only after you define them in the Work Classification Codes setup window.

14. **Set up taxes.** On the Federal/State Tax Codes window, use the Select Federal or State Tax button to find the supported income taxes that you will assign to your company’s employees. For each tax selected, complete the tabs of the Federal/State Tax Codes window and then click Add.
15. **Set up local and custom taxes (U.S. only).** Using the Local/Other Tax Codes setup window, you can find many supported local (county, city, school district, occupational license, and so on) taxes, and you can define your own local or custom taxes that are not supported by Sage.

16. **Set up employee records.** For each employee for whom you process payroll, complete the appropriate tabs of the Employees > View/Edit Employee > Payroll detail pages (Employee Payroll, Employee Activity, Employee Selection Lists).

17. **Set up payroll transaction history.** Use the Transaction History window to enter historical amounts for accruals, advances, benefits, deductions, earnings, expense reimbursements, and taxes, for each employee. Depending on the category and calculation method of the earning/deduction you enter, many of the columns on the Earnings/Deductions tab may not apply.

18. **Set up employee selection lists (optional).** To create selection lists of employees to be used in calculating payroll and printing reports, use the Employee Selection payroll task window.

19. **Set up common deduction limits (optional).** Associate multiple deductions based on a single limit and ensure that employee deductions do not exceed defined maximums (for example, multiple garnishments, retirement plans, and union dues).

20. **Set up EFT for direct deposit payroll (optional).** Use the EFT Options window to set up the company’s bank information, and use the Employee Payroll window to set up employees’ bank information. To enable combining multiple EFT files, use the Combine EFT File window.

21. **Back up your data.** Create and save a backup of your payroll data once everything is set up and before you begin processing payroll. For instructions on backing up your data, see in-product Help.
Navigating Sage HRMS

Sage HRMS provides a few different ways to access your HR, Time Off, Payroll, and Training tasks and processes.

**The Main Menu**

The main menu appears at the top of the program. It is always visible and provides access to all activities.

**The Quick Launch Toolbar**

The Quick Launch toolbar provides access to the Organizer, your installed Sage HRMS products and modules, SAP Crystal Reports®, Sage University, and your installed Microsoft Office applications.

*Note:* If you do not have a product installed, the product icon does not appear on the Quick Launch toolbar.

**The Organizer**

The Organizer enables you to schedule and carry out tasks. You can also record information and plan system events. All uncompleted activities and information are rolled over from day to day. Access the Organizer by clicking the Organizer icon on the Quick Launch toolbar.

**The Scheduler**

The Scheduler enables you to schedule new tasks, information items or system events for yourself or someone else. When you schedule these items, they appear in the Task, Information or System Event list in the Organizer.

**Using the Sage HRMS Desktop**

Sage HRMS Desktop allows you to view and perform your HR, Payroll, Training, and Time Off tasks. The desktop can be customized to suit the way you work.

The desktop is divided in five areas

- **Main Menu.** At the top of the program.
- **Toolbars.** For Employees, Training, and Time Off (if installed).
- **Navigation Pane.** Use the navigation pane to access modules like Employee, Benefits, Payroll, Training, Reports, and System Setup.
- **Work Area.** Displays information related to the module you selected.
• **Status Bar.** Displays status messages.

### Using the Navigation Pane

The navigation pane on the left hand side of the desktop provides quick and easy access to the major features of the application.

**Note:** Groups, tasks, and processes that you do not have security access do not display on the navigation pane.

### Hierarchy in the Navigation Pane

There is a hierarchy in the navigation pane; you will need to select them in the following order.

- **Group.** For example, Employees, Time Off, Training, Reports, Payroll, Setup.
- **Subgroup.** You don’t have to click a subgroup to access the corresponding tasks or processes, but you can expand and collapse a list of tasks or processes in a subgroup.

### Using the Main Menu

When you start Sage HRMS, the main menu is displayed at the top of the program and is always visible.

This toolbar provides access to all items in the Actions, Processes, Analysis, Reports, Rules, Details, and Query menus. When you select an item from these menus, a list opens that contains all the products installed on your system. Some menus include a System selection which includes activities relating to the entire system rather than an individual product.

Each module has its own set of actions, processes, analyses, reports, rules, and details. Move the mouse pointer over a product to drop down the next list. Click an item to select it.

**Note:** Processes or tasks for which you do not have security access do not appear on menus or on the navigation pane. For more information, see [Setting Up Security](#).

### The File Menu

The following table describes these menu items in the File menu.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Preferences</td>
<td>Opens the User Preferences dialog box so you can set specific preferences for how you want to use Sage HRMS.</td>
</tr>
<tr>
<td>Restart Sage HRMS</td>
<td>Automatically restarts your system. Use this after you make certain changes, such as changing the employer filter or the default view in User Preferences.</td>
</tr>
</tbody>
</table>
Menu Item | Function
--- | ---
Logout | Log out of Sage HRMS and you are returned to the Logon window.
Printer Setup... | Opens the Windows Print Setup dialog box. Refer to your Microsoft Windows documentation to set up your printer.

**Note:** If you want to change printers while working in Sage HRMS and the File Menu items are disabled, click the **Windows Start Menu > Settings > Printers**. Right-click the printer you want and choose **Set As Default**.

Exit | Closes the Workspace, Organizer, and all open pages and exits the system.

**The Edit Menu**

The Edit menu contains standard commands generally found in all MS Windows products (such as Cut, Copy, Paste, and Delete).

These edit commands are handy when you type in large amounts of text, such as adding comments or notes to employees. Select the text, then choose to cut, copy, paste, or delete it.

In addition, it enables you to access the Employee Find command to search for an employee.

**The Help Menu**

The Help menu contains standard commands, most of which are found in all Windows products.

The following table describes these menu items.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Opens the Table of Contents for online Help, where you can click the topic for which you want Help.</td>
</tr>
<tr>
<td>Search for Help on...</td>
<td>Opens the Index for online Help. Enter a keyword or phrase and then click Display.</td>
</tr>
<tr>
<td>Additional Documentation</td>
<td>Opens the Sage HRMS Product Documentation website with a list of both current and legacy User Guides, Installation Guides, Implementation Guides, and more.</td>
</tr>
<tr>
<td>Sage Web Site</td>
<td>Opens the Sage North America website in Microsoft Internet Explorer. If you do not have Internet Explorer installed, this option is disabled.</td>
</tr>
<tr>
<td>Sage HRMS Customer Support</td>
<td>Opens the Sage Customer Support website using Internet Explorer. If you do not have Internet Explorer installed, this option is disabled.</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sage Live Chat</td>
<td>Opens the Sage Live Chat Assistance window in Internet Explorer. Chat hours are listed and you must have a current Business Care Support plan and Account ID to get help.</td>
</tr>
<tr>
<td>Sage HRMS Training</td>
<td>Opens the Sage Sage HRMS Train website using Internet Explorer. If you do not have Internet Explorer installed, this option is disabled.</td>
</tr>
<tr>
<td>Sage Source</td>
<td>Directs you to the Sage Source website where you can log onto your personal online workspace. Learn more about Sage Source at <a href="http://www.SageSource.com">www.SageSource.com</a>.</td>
</tr>
<tr>
<td>Product Feedback</td>
<td>Opens the Sage HRMS portal on the IdeaScale website, where you can provide feedback and comments about Sage HRMS. You will have to create an account with IdeaScale in order to provide feedback.</td>
</tr>
<tr>
<td>Show Welcome Page</td>
<td>Opens the Welcome Page and allows you to change the &quot;&quot;).</td>
</tr>
<tr>
<td>Register Sage HRMS...</td>
<td>Gives you the opportunity to register your software; you can enter the Serial Number, Installation Code, and select from additional Sage products that can be integrated with Sage HRMS.</td>
</tr>
<tr>
<td>Register for eFiling</td>
<td>Opens the Sage Payroll Tax Forms and eFiling by Aatrix website, where you can learn more about your eFiling options and register for eFiling.</td>
</tr>
</tbody>
</table>
| About Sage HRMS    | Opens the About Sage HRMS dialog box for you to view information about your system or read the End-User License Agreement.  
If you want to be removed from the Product Enhancement Program, select **I want to opt out of the Product Enhancement Program.**  
If you want to be removed from the Product Survey Program, select **I want to opt out of the Product Survey Program.** |

**Tip:** You can also access context-sensitive Help at any time by clicking the Help button.

**The Employer Filter List**

To set the Employer Filter, click the down arrow and select the Enterprise or the employer you want to work with. The list displays each employer’s description and three letter code.
The system lets you set up more than one employer in your enterprise. All the employees you add to your employers exist in the database. Before you find the employee you want to work with, use the Employer Filter list to filter your employers so it is easier to find the employee.

**Note:** After you add a new employer, you must log out of the system and log back on in order to see the new employer in the Employer Filter drop-down list.

For example, suppose you set up four different employers in your enterprise with a total of 2,500 employees. You want to start processing employee records for just one employer, Z-Systems, Inc. (ZSI). Instead of searching through all 2,500 employees, you can select ZSI from the Employer Filter list to work with only employees assigned to ZSI.

If you set your employer filter to ZSI, only ZSI and its employees are available in the following areas of the system:

- **Employee Find.** When working with detail pages or actions, the system searches through only the records in ZSI to find the employee. Note that each time you change the employer filter and search for an employee, the system adjusts the record set to match the selected filter.

- **Standard reports.** When selecting criteria for reports, only ZSI appears in the Employer drop-down list on the Standard Criteria tab.

- **Rules.** When adding or editing code tables, only ZSI appears in the Employer drop-down list.

- **Analyses.** Only ZSI data appears in the selection tree.

**The Help Button**

The Help button is always accessible to the far right of the Main Menu. Click it to open the online Help for Sage HRMS. Refer to Use Sage HRMS Help to learn how to use online Help.

**Moving Around in a Page**

A page contains several fields into which you enter data or select data from a list. When you work inside a page, you move from field to field to enter information. When you highlight the field, you can enter information into it. The following table lists some ways to move around in a page.

<table>
<thead>
<tr>
<th>Use This</th>
<th>To Perform This Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Move forward from field to field (left to right and top to bottom).</td>
</tr>
<tr>
<td>Shift + Tab</td>
<td>Move from previous field to field (right to left and bottom to top).</td>
</tr>
<tr>
<td>↓↑←→</td>
<td>Move the selection cursor from field to field or within a field.</td>
</tr>
<tr>
<td>Mouse</td>
<td>Place the selection cursor in a field or within a text box.</td>
</tr>
</tbody>
</table>
Using Tabs

Many pages contain two or more tabs. Each tab contains different fields. For example, the Demographics page contains three tabs:

- **Address and Phone** - Contains the employee’s address and phone number.
- **Personal** - Contains the employee’s personal information.
- **Photo** - Contains the employee’s photograph.

To move to another tab, click on the tab label. For example, click the **Personal** tab label to view the Personal page. You can also press the **Right Arrow** → key on your keyboard to move to the next tab or the **Left Arrow** ← key to move to the previous tab.

Selecting From a Drop-Down List Box

To fill in a field, select from a drop-down list box. A drop-down list box lets you select one item from a list of several items.

The following table describes how to open and select items from a drop-down list box. Make sure you highlight the field on which you want to work before you perform the following actions:

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the list using your keyboard</td>
<td>Press the <strong>spacebar</strong>.</td>
</tr>
<tr>
<td>Open the list using your mouse</td>
<td>Click the arrow.</td>
</tr>
<tr>
<td>Close the list using your keyboard</td>
<td>Press the <strong>spacebar</strong>.</td>
</tr>
<tr>
<td>Close the list using your mouse</td>
<td>Select an item or click outside the list.</td>
</tr>
<tr>
<td>Select an item using your keyboard</td>
<td>From either an open or closed list, type the first letter of the item, or press ↑ or ↓ to find the item.</td>
</tr>
<tr>
<td>Select an item using your mouse</td>
<td>From an open list, click the item.</td>
</tr>
</tbody>
</table>

Entering Text in a Text Box

For a description of the database files used by Sage HRMS, including field names and lengths, refer to the Data Dictionary Overview.

Entering information in a text box is another way to fill in a field. Each text box limits the number of characters or digits you can enter. The Data Dictionary contains the limit for each database field.
Note: If you are using the add-on import/export application, Sage HRMS Link, to export your data to ADP PC/Exchange, note that some fields may have more characters than ADP can accommodate. For a description of these fields, refer to your Sage HRMS Link manual.

The following table describes the different functions you can perform inside a text box.

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter information in a blank field</td>
<td>Type characters and digits up to the field maximum.</td>
</tr>
<tr>
<td>Replace information in a field</td>
<td>Click and drag the mouse over the field to highlight; then type characters and digits up to the field maximum.</td>
</tr>
<tr>
<td>Delete all characters in a field</td>
<td>Click and drag the mouse over the field to highlight and click <strong>Delete</strong>.</td>
</tr>
<tr>
<td>Delete one character in a field</td>
<td>Place the cursor to the left of the character to delete and click <strong>Delete</strong>.</td>
</tr>
<tr>
<td>Insert one character in a field</td>
<td>Place the cursor to the right of the insertion point and type.</td>
</tr>
</tbody>
</table>

**To Enter a Date in a Text Box**

Entering a date in a text box is a bit different from entering text in a text box. A date always contains the month, day, and year. Therefore, the slashes between the month and day are permanently included in the text box.

To type a date into a text box, highlight the field. Then, type two digits for the month, two digits for the day, and four digits for the year. For example, we typed "01111953" for the figure above.

As an alternative to typing the date, you can click the right mouse button. A calendar control opens enabling you to select a date from the calendar display. The calendar opens displaying the current date circled in red. Click a date to select it and close the calendar. Selected dates are highlighted in gray.

Clicking the arrows in the top left or top right of the calendar displays the previous or next month. Click on the month to display a pop-up menu that lists all months within the year. Select a month from the list.

Click on the year to display arrows which enable you to move the year up or down. Return to the current day by clicking **Today** at the bottom of the calendar.

Click **OK** to close the calendar. The date you selected appears in the text box.

To change an existing date, right-click the field to open the calendar, or highlight the date and do one of the following:

- Type the new date
- Click + or - to increase or decrease the date
Close and Resize pages

To close a page, click the Close button located in the top right-hand corner of the page title bar. If you have made changes, the system will ask whether you want to save your changes. Yes saves the changes and close the page; No closes the page without saving the changes.

To enlarge a page, click the Maximize button located in the top right-hand corner of the title bar. If the page is already enlarged, you can reduce its size by clicking the Restore button.

Access Context-Sensitive Help

You can access Help for each page by clicking the Help button on the actual page you are working in. This provides information about the page with which you are working.

Shortcut Keys

Sage HRMS is designed to be used with a mouse pointing device. By using the mouse, it is easier to point to and select fields and buttons on the page. However, in some situations, you might find it easier to use your keyboard. Sage HRMS adheres to the Microsoft Windows standard for mouse-equivalent keystrokes.

Accessing the Main Menu

Instead of using the mouse, you can use the keyboard to access and select items from the Main Menu. For instance, instead of clicking on Analysis, you can hold down Alt and press L. To access Processes, hold down Alt and press R. The underlined letter in each menu category indicates the letter to press to select the menu category.

<table>
<thead>
<tr>
<th>Press This</th>
<th>To Select this Menu Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + F</td>
<td>File</td>
</tr>
<tr>
<td>Alt + E</td>
<td>Edit</td>
</tr>
<tr>
<td>Alt + I</td>
<td>Actions</td>
</tr>
<tr>
<td>Alt + R</td>
<td>Processes</td>
</tr>
<tr>
<td>Alt + L</td>
<td>Analysis</td>
</tr>
<tr>
<td>Alt + R</td>
<td>Reports</td>
</tr>
<tr>
<td>Alt + U</td>
<td>Rules</td>
</tr>
</tbody>
</table>
After you have selected a Main Menu item, you can use the keyboard to do one of the following:

- Press ↓ to navigate to the other options for the selected menu item.
- Press → to highlight the next menu category.
- Press one of the underlined letters to display the corresponding drop-down menu.
- Press Enter to open the selected menu item.
- Press Esc to cancel your action and return to the task on which you were working.

**Note:** Certain hot keys may change when you access certain pages in Sage HRMS. If there is more than one item with the same hot key, you can press the hot key again to toggle between them. Press ↓ to access the options for the selected menu item.

### Using the Tab Key

Use the **Tab** key to move from one field to another within a page or dialog box. For example, as you complete the Record New Hire action, the Add New Employee page enables you to enter a first, middle, and last name for the new employee. After you enter the first name, press Tab to move to the middle name field. You can also press and hold down **Shift** and press **Tab** to move up or backwards one field.

This feature is particularly useful when you are working on a page which contains many fields. You can keep your hands on the keyboard while you navigate around the fields in the page using the **Tab** key.

### Using the Edit Keys

You can use the standard Windows edit features to cut, copy, paste selected text.

<table>
<thead>
<tr>
<th>Press This</th>
<th>To Open this Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Employee Find</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts

You can use the keyboard shortcuts to open pages and move from one page to another. These shortcut keys might be different for a customized system or if you do not have access to every page.

<table>
<thead>
<tr>
<th>Press This</th>
<th>To Open this Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Context Sensitive Help</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Absence Transactions</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Attendance Summary</td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Current Job</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Current Pay</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Demographics</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Dependents and Beneficiaries</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>HR Status</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Insurance Benefits</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Job History</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Leave of Absence</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Savings Benefits</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Termination</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Custom Details</td>
</tr>
</tbody>
</table>

**Note:** Press Ctrl + U on the Logon page to update system files.

<table>
<thead>
<tr>
<th>Press This</th>
<th>To Open this Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + M</td>
<td>Employee Activity</td>
</tr>
<tr>
<td>Ctrl + 4</td>
<td>Employee Payroll</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Transaction History</td>
</tr>
</tbody>
</table>

Finding an Employee

The Employee Find enables you to search for an employee by status, last and first name, ID and Social Security Number.

You will need to find an employee before you can view details and perform tasks.
Fields on the Employee Find

The following fields are available on the Employee Find:

<table>
<thead>
<tr>
<th>Search Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Enter a value to search by the last name. When searching by Last Name and First Name, the Last Name field acts as a &quot;go to&quot; feature navigating you to the matching name on the list.</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter a value to search by the first name. When searching by Last Name and First Name, the First Name field acts as a filter, narrowing down your search to the employees with that value you enter in the field.</td>
</tr>
<tr>
<td>ID</td>
<td>Enter a value to search by the employee ID.</td>
</tr>
<tr>
<td>SSN</td>
<td>Enter a value to search by the Social Security Number.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this option to include active employees.</td>
</tr>
<tr>
<td>Terminated</td>
<td>Select this option to include terminated employees.</td>
</tr>
<tr>
<td>LOA</td>
<td>Select this option to include employees on leave of absence.</td>
</tr>
<tr>
<td>Other</td>
<td>Select this option to include other statuses like COBRA dependents, or non-employees.</td>
</tr>
</tbody>
</table>

Find an Employee

1. From the navigation pane, select Employees > View/Edit Employee. The Employee Find page will display.

   **Note:** To open the Employee Find page, you can also use the shortcut key combination CTRL+F.

2. Select the statuses you want to work with (Active, Terminated, LOA, or Other). Disable the ones you don't want to include in the search. The number of Records Found will be based on status.

3. Enter the search criteria in the fields. As you type the values in the field, the system will highlight the matching record, or closest matching record in the search results.

   **Note:** If you enter a value and the system does not find a match, "Not Found" will display next to the search field.
Navigating through a list of Employees on Detail Pages

You have the ability to navigate through the list of employees from your initial search by using the First, Previous, Next, and Last buttons on the Employee Information Bar.

Using Advanced Find

The Advanced Find is accessed by selecting More Options on the Employee Find page. With the Advanced Find you can further narrow your search by entering additional criteria about organization levels, supervisor, employee type, as well as other fields.

When using Advanced Find, the search results expand to display the additional criteria fields.

**Note:** Collapsing the Advanced Find saves the search criteria for the next time you open the Advanced Find. However, when it is collapsed, the Advanced Find search criteria does not affect the navigation.

**Fields on the Advanced Find**

<table>
<thead>
<tr>
<th>Search Field</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Organization Levels (1 thru 5) | Search by organization levels that you have specified in Enterprise Setup.  
If All is selected, all records are considered in the search results.  
If None Specified is selected, only employees without values in the corresponding fields are considered in the search results.  
**Note:** If an Organization Level Title does not exist, the label will display as None. |
| Supervisor | Search by a list of primary supervisors.  
If All is selected, all records are considered in the search results.  
If None Specified is selected, only employees without a primary supervisor are considered in the search results.  
**Note:** If an employer is selected in the Employer Filter, only supervisors for the selected employer are available. If the Enterprise is selected, all supervisors in the system are available. |
### Search Field | Definition
--- | ---
**Employee Type** | Search by the employee type. If **All** is selected, all records are considered in the search results.

**Salaried/Hourly** | Search by the employee’s salary or hourly status. If **All** is selected, all records are considered in the search results.

**Job Title** | Search by job title by the following methods:

- Choose **Contains** and enter a specific search string. All employees whose job title contains the search string are found.
- Choose **Exact** and select a specific job title from the drop-down list.

**State** | Search by state.

**Last Hire Date** | Search by last hire date. Enter a "From" and "To" Date to search by.

If **From** and **To** dates are entered, the search results display all employees with the matching criteria.

**Note:** You have the option to search only with a **From** or only with a **To** date.

### Using the Advanced Find

1. From the navigation pane, select **Employees > View/Edit Employee**. The Employee Find page displays.
2. Select **More Options**.
3. Enter criteria in the fields to narrow your search. Results will display in the list with the closet matching record.

### Employee Information Bar

The Employee Information Bar appears on Detail Pages and enables you to quickly invoke the Employee Find, Employee Quick Find, or navigate through a list of employees you have searched for.

### Fields and Buttons on the Employee Information Bar

| Field/Button | Definition |
--- | ---|

Sage HRMS Getting Started Guide - 25
<table>
<thead>
<tr>
<th>Field/Button</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Displays the employee name</td>
</tr>
<tr>
<td>SSN/SIN</td>
<td>Displays the employee's social security or social insurance number</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the employee’s status</td>
</tr>
<tr>
<td>ID Number</td>
<td>Displays the employee ID</td>
</tr>
<tr>
<td>Find</td>
<td>Opens the Employee Find</td>
</tr>
<tr>
<td>First</td>
<td>Navigate to the first record on the search results list</td>
</tr>
<tr>
<td>Previous</td>
<td>Navigate to the previous record you were viewing</td>
</tr>
<tr>
<td>Next</td>
<td>Navigate to the next record on the search results list</td>
</tr>
<tr>
<td>Last</td>
<td>Navigate to the last record on the search results list</td>
</tr>
</tbody>
</table>

### Using the Quick Launch Toolbar

The Quick Launch toolbar at the bottom of the desktop window provides shortcut buttons that allow you to quickly access Sage HRMS features, office applications, links, interfaces, and other product functionality.

**Quick Launch toolbar buttons**

Sage HRMS provides the following buttons on the Quick Launch toolbar:

- **Organizer.** Allows you to access the Organizer.
- **Who's Online.** Click this button to open the Who’s Online page, which allows you to see the list of users currently logged on to Sage HRMS.
- **Crystal.** Click this button to launch SAP Crystal Reports®.
- **Gross-Up Calculator.** Click this button to launch the Gross-Up Calculator if Payroll is installed.
- **Office.** Click this button to open a menu that displays shortcuts to your installed Microsoft Office applications. Click a shortcut to launch that application.

**Note:** Icons for the following Microsoft Office products will appear if the products are installed on your hard drive or on a network and registered in your Windows registry file: Word, Excel, PowerPoint, Outlook, and Internet Explorer. If you have none of these applications installed, the Office button will not appear.

- **Sage Live Chat.** Click this button to launch Live Chat with a skilled Customer Support analyst for Sage HRMS.
- **Sage Source.** Click this button to launch Sage Source, if registered.
• **Links.** Access the integrations registered on your system. Available links are:
  
  - Sage 100 Standard ERP Link
  - Sage 100 Advanced ERP G/L Link
  - Sage 500 ERP G/L Link
  - Sage ERP X3 G/L Interface

• **Sage University.** Click this button to visit Sage University and access training libraries and courses to learn more about using and maximizing Sage products.

• **Employee Self Service.** Click this button to launch Sage Employee Self Service (if installed).

## Using the Organizer and Scheduler

The Organizer shows you tasks and information items scheduled for you. The Organizer includes the Scheduler, which allows you to plan tasks for yourself or someone else.

Click the Organizer icon on the Quick Launch toolbar to open the Organizer.

---

**Note:** Select Organizer in the Default View field on the User Preferences window if you want the Organizer to open in the workspace after you log on to Sage HRMS.

---

### To Use the Organizer

The Organizer you see when you use Sage HRMS is your own personal Organizer; all scheduled tasks and information items are yours.

The Organizer first opens to the current date and provides three lists: tasks, information, and system events. It displays all tasks, messages, and events scheduled for the current date.

Using the Organizer lists, you can schedule and carry out tasks. You can also record information and plan system events. All uncompleted activities and information are rolled over from day to day.

### Move Around in the Organizer

Use any of the following methods to move around the calendar:

- To jump to the current date, click the **Date** button on the Organizer toolbar.
- To move to a different day in the current month, click the day in the calendar.
- To move to a different month, right-click the month. A list drops down from which you can select a new month.
- You can also move to the previous month by clicking the first date in the calendar or any date belonging to the previous month, or move to the next month by clicking the last date in the calendar or any date belonging to the next month.
- To move to another year, right-click the year. A list drops down from which you can select a different year.
You can also use the keyboard to move to a different date, as described in the following table.

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Press This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the previous day.</td>
<td>←</td>
</tr>
<tr>
<td>Move to the next day.</td>
<td>→</td>
</tr>
<tr>
<td>Move to the previous week.</td>
<td>↑</td>
</tr>
<tr>
<td>Move to the next week.</td>
<td>↓</td>
</tr>
<tr>
<td>Move to the beginning of the month.</td>
<td>Home</td>
</tr>
<tr>
<td>Move to the end of the month.</td>
<td>End</td>
</tr>
<tr>
<td>Move to the previous month.</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move to the next month.</td>
<td>Page Down</td>
</tr>
</tbody>
</table>

### Use the Organizer Toolbar

The Organizer toolbar, located just above the Organizer, enables you to start tasks, jump to today’s date, schedule items, delete or edit items in the lists, and update the Organizer.

The Organizer toolbar contains six buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Checkmark]</td>
<td>Execute a Task</td>
<td>Use this button to complete a specific task in the Task list. To start a task, click the <strong>task description</strong> and click the <strong>Start</strong> button.</td>
</tr>
<tr>
<td>Tip: Instead of using the <strong>Start</strong> button, you can also double-click the task to start it.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Depending on what the task is, the first scheduled step in the task appears. For example, if you scheduled the Add New Hire task as your task and you start the task, the Add New Employee dialog box opens for you to enter the name of the new employee. This is the first step for recording a new hire.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The only type of item you can start is a task. However, you can edit or</td>
</tr>
</tbody>
</table>

Sage HRMS Getting Started Guide - 28
Navigating Sage HRMS

Button | Button Name | Description
---|---|---
delete all types of items, including tasks, information items, and system events.

<table>
<thead>
<tr>
<th>Jump to Today's Date</th>
<th>The Date button enables you to quickly jump to the current date.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Add Item to Scheduler</th>
<th>The Scheduler lets you schedule a new task, information item or system event. To access the Scheduler, click the Scheduler button.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Delete Item in Scheduler</th>
<th>The Delete button deletes a task, information item or system event. As a precaution, the system asks you to confirm the deletion. To delete an item, highlight it and click the Delete button.</th>
</tr>
</thead>
</table>

**Note:** A system event can only be deleted by the user for whom it is scheduled.

<table>
<thead>
<tr>
<th>Edit Item in Scheduler</th>
<th>The Edit button enables you to change information for a specific item. To edit an item, highlight it and click the Edit button. The Scheduler opens for you to edit the item's information.</th>
</tr>
</thead>
</table>

**Note:** A system event can only be edited by the user for whom it is scheduled.

<table>
<thead>
<tr>
<th>Refresh Organizer</th>
<th>The system frequently refreshes your Organizer and brings it up to date with items other users might have scheduled for you. Additionally, you can click the Update button any time you want to refresh your Organizer.</th>
</tr>
</thead>
</table>

**Use the Organizer Lists**

Consider these your "to-do" lists. You use the Scheduler to place items on these lists. At a glance, you can browse through all tasks, information items and system events that were placed on your Organizer for the selected day.

Items on the list are either completed or uncompleted. All uncompleted tasks and information items scheduled for dates prior to the current day are rolled over when you log on to the system.

There are three lists in the Organizer:

- A task is an Action, Process, Report, Analysis, Rule, or Detail. When you schedule a task, it appears on your Organizer or another user's Organizer if you scheduled it for someone else.

The Task list shows all tasks scheduled for you. At the time you complete the scheduled task, the Completed field is automatically selected, indicating the task has been completed.

The following table describes how to work with the Task list.
<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
</table>
| To start a Task                | Click the task and click the **Execute a Task** button.  
- or -  
Double-click the task.       |
| Edit a Task                    | Click the task and click the **Edit Item in Scheduler** button.  
- or -  
Click the + button next to the task.  
The Scheduler appears. Change the necessary information. |
| Delete a Task                  | Click the task and click the **Delete Item in Scheduler** button. Confirm the deletion.  
- or -  
Click the + button next to the task. The Scheduler appears. Click **Delete**.  
Confirm the deletion. |
| Display the task's Note page   | Right-click the task.  
The Notes page opens. Edit the information as necessary. Click **OK** to save your changes and return to the Organizer. |
| Note                           | You can also edit Notes in the Scheduler.                                                                                           |
| See tasks that extend beyond   | Use the vertical and horizontal scroll bars.                                                                                         |
| the list                       |                                                                                                                                 |
| Change status to Completed     | Select the **Completed** check box.  
- or -  
Click the task and click the **Edit** button to open the Scheduler. Select the **This Item is Complete** check box.  
- or -  
The system detects when the item is complete and automatically selects the **Completed** check box. |
| Change status to not completed | Clear the **Completed** check box.  
- or -  

To Do This

Click the task and click the **Edit** button to open the Scheduler. Clear the **This Item is Complete** check box.

**Note:** You can only clear a **Completed** check box for tasks completed on the current day. When viewing past dates, you cannot change the status to not completed.

Use the Information list to schedule any type of information. You can use this as a personal to-do list to remind yourself of anything from scheduling a meeting to making hotel reservations for your next business trip.

Like the Task list, the **Completed** field indicates the completion status. However, an information item is not an Action, Process, Analysis, Report, Rule, or Detail, so your system cannot detect whether or not it is complete. You must change an information item’s status.

The following table describes how to work with the Information list.

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
</table>
| **Edit an Information Item** | Click the information item and click the **Edit Item in Scheduler** button to open the Scheduler.  
- or -  
Click the + button next to the item to open the Scheduler. Change the necessary information. |
| **Delete an Information Item** | Click the information item and click the **Delete Item in Scheduler** button. Confirm the deletion.  
- or -  
Click the + button next to the item. The Scheduler appears. Click **Delete**. Confirm the deletion. |
| **Display the item’s Note page** | Right-click the Information item. The Notes page opens. Edit the information as necessary. Click **OK** to save your changes and return to the Organizer.  
**Note:** You can also edit Notes in the Scheduler. |
| **See items that extend beyond the list** | Use the vertical and horizontal scroll bars. |
Navigating Sage HRMS

Use the System Event List

If you need to schedule a task that pertains to the entire system, you can schedule a system event. You can schedule any task to be a system event, that is, any Action, Process, Analysis, Report, Rule, or Detail.

You can also schedule an information item as a system event if you like. For example, you can remind everyone to back up their databases every Friday.

The following table describes how to work with the System Event list.

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
</table>
| Change status to Completed | Select the **Completed** check box.  
  - or -  
  Click the information item and click the **Edit** button to open the Scheduler. Select the **This Item is Complete** check box. |
| Change status to not completed | Clear the **Completed** check box.  
  - or -  
  Click the information item and click the **Edit** button to open the Scheduler. Clear the **This Item is Complete** check box. |

Note: Only the user for whom the system event is scheduled can edit it.

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
</table>
| Edit a system event | Click the system event and click the **Edit Item in Scheduler** button to open the Scheduler.  
  - or -  
  Click the + button next to the event to open the Scheduler. Change the necessary information. |

**Note:** Only the user for whom the system event is scheduled can edit it.

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
</table>
| Delete a system event | Click the system event field and click the **Delete Item in Scheduler** button. Confirm the deletion.  
  - or -  
  Click the + button next to the event. The Scheduler appears. Click **Delete**. Confirm the deletion. |

**Note:** Only the user for whom the system event is scheduled can delete
To | Do This
---|---
| it.
| Right-click the system event. The Notes page opens. Edit the information as necessary. Click OK to save your changes and return to the Organizer.
| Use the vertical and horizontal scroll bars.

### Use the Scheduler

The Scheduler lets you schedule tasks, information or system events for yourself or someone else. When you schedule these items, they appear in either the Task, Information, or System Event list on the Organizer.

**Note:** Tasks can only be scheduled for users who have access to the tasks. For example, you might want to schedule your coworker, Liz, to delete several employees from the database. However, Liz does not have security access to the Delete Employee Record action. Therefore, you cannot schedule this task for her.

The Organizer first displays the lists according to the item’s priority you designate when you schedule the item. Items with the highest priority appear at the top of the list while items with the lowest priority appear at the bottom. The Organizer then sorts the items in the order in which they were scheduled.

An item appears on your Organizer until it is completed or deleted.

**To Schedule an Item**

With the Organizer open, click the **Add Item to Scheduler** button on the toolbar to open the Scheduler.

**Schedule a Task or Information Item**

Click the appropriate radio button, either **Task** or **Information**, for the type of item you are scheduling. When you select Information, the **Activity** and **Product** fields are disabled because they do not apply to information items.

**Select the Task’s Activity**

This field specifies the activity containing the task. For example, if you schedule the Mass Update task, select **Process**. Or if you are scheduling the Rehire Employee task, select **Action**. These two tasks, Mass Update and Rehire Employee, are a process and an action, respectively.

**Select the Task’s Product**

All Sage HRMS products appear in this list, as well as System. System includes activities pertaining to your entire system rather than an individual product.

**Select the Task**
This field contains the task you are scheduling. The list contains all the tasks included in the selected task's activity and product. The list changes when the task's activity and product change.

If you are scheduling an information item, the Task field is disabled.

Select the Sub-Task
Some tasks have associated sub-tasks. A sub-task is simply another level of task within the task you select. If sub-tasks do not apply to your selected task, the field is disabled.

Select the Employer
For most tasks, you are required to select an employer. For example, if you are working with Sage HRMS and select the Record Performance Review action, you must select which employer contains the employee for whom you want to record a performance review.

The Employer field is disabled if there is only one employer set up in your enterprise or if the task is an Information item.

Select a Subject
Tasks require specific information before they are processed. For example, the Rehire Employee action requires an employee's name. The items in the list change according to the task you select. If you forget to select a subject, the system warns you when you click OK to close the Scheduler.

If you are scheduling an information item, the Subject field is disabled.

Enter a Description
This is a short description of the task, information item or system event. The description appears on the Organizer of the user for whom the item is scheduled. If you are scheduling a task, the system fills in the description automatically by combining the task (or sub-task, if one is selected) and the subject.

You can change the Description field as necessary, but you cannot leave it blank. If you accidentally leave the Description field blank, the system fills it in for you.

Add a Note
The Notes text area of the Scheduler enables you to fully describe the item. You can enter an unlimited number of characters. Use the scroll bars as necessary.

When you work with the Organizer and want to see the note associated with a task, information item or system event, right-click the item to read and edit the note.

Schedule the Date To Be Done
This is the date on which the item is scheduled for completion. The item appears on the Organizer on this date. Sage HRMS automatically schedules the item for the day currently selected in the calendar, but you change the date.

Enter the To Be Done date in mm/dd/yyyy format. For example, enter March 27, 2007 as 03272007 (slashes are preformatted).

The Scheduled date is the date on which the item is being scheduled. It defaults to the current date and cannot be changed.

Automatic Advancement of Uncompleted Items
If tasks or information items are not completed on the scheduled dates, the system automatically rolls them over to the next time the user logs into the system. For example, a task on Lynn’s Organizer should be completed on the 18th, but Lynn cannot complete the task on the 18th. She doesn’t use her system again until the 23rd. The task rolls over to the 23rd and stays on her Organizer until she either completes or deletes the task.

**Note:** Unlike tasks and information items, system events are not moved forward.

**Select the User for Whom the Item is Scheduled**

The Scheduled For list contains users who are assigned user IDs and passwords when security was set up for your system. If you are scheduling a task, only the users who have security rights to perform that task appear in the list. For more information, see Setting Up Security.

**Note:** The name of the user who is scheduling the item is shown in the Scheduled By field and cannot be changed. This is the user who logged into the system.

**Set the Priority**

You can choose from five levels of item priority: very high, high, medium, low, and very low. This indicates the importance of the item you are scheduling. The selected priority determines the order in the Organizer’s tasks and information lists.

**Set the Frequency**

The Frequency indicates how many times the item should occur. The list includes Once, Daily, Weekly, Bi-Weekly, Monthly, Bi-Monthly, Quarterly, and Yearly. If you want the task to repeat, select any frequency other than Once.

For example, you might want to archive terminated employees once a month. In this case, select Monthly as the frequency.

When you select a frequency, the Repeating Task dialog box automatically opens for you to describe the task’s repeat frequency.

The text entered in the Scheduler’s Description text area appears in the Task Information field. The Scheduled Date and Repeat Frequency carry over from the Scheduler. These three fields cannot be changed.

**Repeat Items**

The Repeat This Item field lets you specify the number of times to repeat this item. Except for a Repeat Frequency of Daily, you can repeat an item as many times as required up to a five year limit. For a daily repeat frequency, you can repeat an item up to 365 times.

The Repeat Frequency is the number of times an item will appear on the Organizer in addition to the first date you schedule. For example, if you schedule an item to be done on Tuesday, 4/12, and the repeat frequency is weekly and the number of times you want to repeat the item is three, then your Organizer shows the item on 4/12 (the first occurrence), 4/19, 4/26, and 5/3.
Use the arrows to select the repeat number or type a number in the text box. However, if you type a number exceeding the Repeat Frequency limit, the number automatically changes to the allowable limit. For example, if you type 6 for the number of years an item is to occur, the number automatically changes to 5, the allowable limit.

**Tip:** Each time you schedule an item to be repeated, the repeat occurrence of the item is a separately scheduled item. If you edit a repeat item, the **Frequency** field on the Scheduler is disabled. If you find you need to change the repeat frequency of an item that is already scheduled to repeat, do not edit the item. Rather, schedule a new item and its related repeat frequency. Then, delete the old item.

**Maintain the Day of the Week**

You can choose to maintain the day of the week the item repeats. For example, if you always want to repeat the item on a Thursday, select the check box and select Thursday from the drop-down list.

If maintaining the day of the week does not matter, clear the check box. The item then repeats on the same numerical date of the month. For example, if you schedule an item on April 15 and you want it repeated every month, the next occurrences will be May 15, June 15, July 15, and so on, regardless of the day of the week.

If the box is selected, the **Move to Closest Date**, **Forward to Next Available Date**, and **Backward to Last Available Date** options become enabled.

**Note:** The **Maintain Day of Week** check box and drop-down list are disabled when your **Repeat Frequency** is daily, weekly, or biweekly, because they do not apply. In turn, the related radio buttons are disabled.

**Move to Closest Date**

This selection instructs the Scheduler to repeat the task on the date falling closest to the next date to repeat the task while at the same time maintaining the day of the week. This selection lets the Scheduler choose the next date to repeat the task. It either chooses a date previous to or following the scheduled repeat date. **Move to Closest Date** is the default value.

For example, suppose you want to repeat an item monthly and always want it to be done on Wednesday. Schedule the first task for Wednesday, 11/17. In December, the 17th falls on a Friday. The **Move to Closest Date** selection tells the Scheduler to move this task to Wednesday, 12/15 because it is only two days from the 17th, whereas the 22nd, also a Wednesday, is five days from the 17th.

**Forward to Next Available Date**

This selection instructs the Scheduler to repeat the task on whatever the date is that matches the specified day of the week and follows the date on which the task is to be repeated. Unlike **Move to Closest Date** or **Backward to Last Available Date**, the Scheduler must move forward to select the repeat task date.
Using the same example as above, you want to repeat an item monthly and always want it to be done on Wednesday. You scheduled the first task to be done Wednesday, 11/17. In December, the 17th falls on a Friday. The **Forward to Next Available Date** selection tells the Scheduler to move this task to Wednesday, 12/22, because it must move forward to the 22nd, not backward to the 15th.

**Backward to Last Available Date**

This selection instructs the Scheduler to repeat the task on whatever the date is that matches the specified day of the week and precedes the date to repeat the task. Unlike **Move to Closest Date** and **Forward to Next Available Date**, the Scheduler must move backward to select the repeat task date.

Using the same example as above, you want to repeat an item monthly and always want it to be done on Wednesday. You scheduled the first task to be done Wednesday, 11/17. In December, the 17th falls on a Friday. The **Backward to Last Available Date** selection tells the Scheduler to move this task to Wednesday, 12/15, because it must move backward to the 15th, not forward to the 22nd.

When you complete setting values for the Repeating Task dialog box, click **OK** to save the changes and return to the Scheduler.

**Schedule a Task in Microsoft Outlook**

When you schedule a task in the Scheduler, you can also schedule it in Outlook. User Preferences enables you to set the check box as always selected.

When the Schedule Task in Microsoft Outlook check box is enabled, an e-mail of the task is sent to the person for whom it is scheduled. When they accept the task, it is scheduled in their Outlook Task Manager.

If the person declines the task in Outlook, an e-mail is sent to the person who scheduled the task; however, the task is not updated in the Scheduler.

After the task is completed in Sage HRMS, it is automatically marked as completed in Outlook.

---

**Note:** Refer to the Microsoft Outlook online help for further information regarding the features of Outlook.

**Schedule a System Event**

You can schedule a system-wide item, a System Event, pertaining to all users on the system. To schedule a System Event, select **System Event** from the **Priority** drop-down list.

Scheduling a System Event is a bit different from scheduling a Task or Information item. When you schedule a System Event, it is automatically placed on your Organizer in the System Event list and it is placed on every Sage HRMS user's Organizer as well. This allows you to convey a message to all other users on the system.

**Here are two examples of a system event:**

Suppose you want to perform the Mass Update process in Sage HRMS on December 5 at 5:00 PM. You need all other users on the system to exit Sage HRMS before 5:00 so you can run the process.
1. In Sage HRMS, schedule the Mass Update process for yourself (the default) with the Priority as System Event. Schedule the process to be done 12/5/07. Add a message in the Note text area: "Mass Update will occur at 5:00 today, December 5. Please exit Sage HRMS by 4:55 PM."

2. The Mass Update process appears on everyone’s Organizer in the System Event section on December 5. Each user can view the note by clicking the + button next to the item to open the scheduler, or by right-clicking the item. That way, all users know to exit Sage HRMS before 5:00. However, the Mass Update process only appears in the Task section of the person scheduled to complete it.

Let's say you routinely perform E-mail maintenance every Friday at 5:30 and want all users to exit E-mail before you begin maintenance work.

1. Since this is not a system task, schedule this as an Information item. Specify the Frequency as Weekly and the Priority as System Event. Add a message in the Note text area: "Please exit E-mail by 5:30 today for weekly maintenance."

2. The Information item is placed on everyone's Organizer each Friday. Users can view the note by clicking the + button next to the item to open the scheduler, or by right-clicking the item.

**Note:** Only the user for whom the system event is scheduled can edit, delete, or reschedule the system event.

---

**Mark an Item as Complete**

The Task has been completed check box in the lower left corner of the Scheduler indicates if the item is complete. When you edit a Task or an Information item, the Scheduler opens with this check box enabled.

To signify the item is complete, select the check box. If you are editing a task you have completed, the system automatically marks the item as complete. When you click OK to return to the Organizer, the item’s Completed check box is selected.

The Task has been completed check box is disabled when you:

- Schedule a new task or information item.
- Schedule a system event, as there is no completed status for a system event.
- Edit an item completed prior to the current day.
Before adding employers and setting up their different requirements, you must set up the enterprise. The Sage HRMS enterprise feature lets you handle a group of employers as one. The enterprise is an efficient time-saver used to manage multiple employers. The enterprise has no employees, but it does provide access to code tables that set the standards for your system.

### Understanding the Enterprise

The enterprise lets you group employers together and handle them as one. An enterprise is not actually an employer, even though it appears in a list of employers on your system. The enterprise has no employees, but it does help you establish standards for all the employers in your system.

Think of the enterprise as the "corporate level," encompassing all employers under a single umbrella. You have only one enterprise in your system, but you can have numerous employers.

Each employer can have different setup specifications, such as different codes for the jobs in the company or different salary grade structures. When you set up your employers, you can specify different sets of specifications for each employer.

The enterprise feature helps you in two ways:

- You save time because it allows you to manipulate several employers' data at one time rather than working with individual employers to complete identical tasks one at a time.
- The information from all your employers is available to you when you are viewing data or printing reports.

### Enterprise as a Time-Saver

The enterprise feature saves you time when you are setting up and managing multiple employers. For example, you have an umbrella corporation called National Systems, Inc., with three subsidiary employers called A Corp., B Corp., and C Corp. The umbrella company, National Systems, and its three subsidiaries all have the same benefit plans.

If you are using Sage HRMS, all the codes in the enterprise benefit plan code table apply to all employers in your system, unless you set up a different plan for a particular employer.

Therefore, when you first set up your three corporations, A Corp., B Corp., and C Corp., they automatically use the enterprise benefit plan code tables. You do not have to set up separate benefit plans for each employer because they all conform to the enterprise standards.

If you need to set up a unique plan for one of your employers, the enterprise still saves you time. Copy an enterprise benefit plan to the employer, make your changes and save the benefit table with an employer code. Now you have a unique benefit plan for this employer and you did not have to create it from scratch.
The enterprise also efficiently handles changes to your setup. For example, if you have a rate change in a dental plan and three employers use the enterprise dental plan, simply change the rate once in the enterprise dental plan rather than three times. The rate change you make at the enterprise level affects every employer in your system except those who have unique dental plans.

**Enterprise as the Panoramic View**

Use the enterprise feature to see a panoramic view of information in Sage HRMS. For example, when you print a report, select the enterprise and Sage HRMS prints information from all your employers in one report. When using the filter feature to control the information you want to use, select the enterprise to give yourself access to data for all employers in the system.

**Setting Up the Enterprise**

Log on to Sage HRMS. From the navigation pane, select **Setup > System > Setup > Enterprise Setup**.

After you define the enterprise setup information, click **OK** to accept your changes and close the Enterprise Setup page. You can also click **Apply** to save your changes but remain on the page. For example, you may want to enter information on the **Enterprise Options** tab, click **Apply** to save your changes, then move to the **Organization Titles** tab.

**Define Enterprise Options**

The **Enterprise Options** tab of the Enterprise Setup page contains general setup information for your system.

**Country.** Select the country that represents the employers in your enterprise. The country you select determines what information is displayed in your Sage HRMS system. For example, if an entire Detail page or a particular field on a Detail page does not apply for a country, it either does not display or it is disabled for an employer in that country.

- Select **U.S.** if all employers in the enterprise are United States employers.
- Select **Canada** if all employers in the enterprise are Canadian employers.
- Select **Both** if there are both United States and Canadian employers in the enterprise.

The first time you log on to Sage HRMS, the system asks you for a country setting for your employers. If you need to change the country setting after the initial setting, you can do so on the Enterprise Setup page. When you change the country setting, you must exit Sage HRMS and log on again to complete the country setting change.

**Note:** After initial setup of your enterprise, if you re-register with a new installation code to either add U.S. payroll to a Canadian payroll system or add Canadian payroll to a U.S. payroll system, you must change the Country setting to **Both** after re-registering and restarting Sage HRMS.
Define Organization Titles

The Organization Titles tab of the Enterprise Setup page enables you to define up to five organization levels for your enterprise. Use these levels as a way to organize your employees.

For example, Richard Miller accepts a marketing position with Multimedia Communications. You add the new employee (Richard Miller) to one of your employers, Multimedia Communications. You specify the department as Marketing and the division as Central. For this example, you define two Organization Titles: Department and Division.

After defining the organization titles, set up the codes for each organization title in your Organization code tables. In the above example, Marketing is a code under the Department organization title and Central is a code under the Division organization title.

Enter titles for up to five organization levels.

When you set up your Organization code tables, you can choose from this list of titles for your enterprise's organization levels and then set up the codes for each organization level.

Select the Enterprise Logo

The reports you generate within Sage HRMS can include the name and address of your employer as well as a logo for your enterprise. The Logo Setup tab of the Enterprise Setup page enables you to select your logo.

Before selecting a logo, you must be able to access it as a bitmap file, a file with the .BMP extension. A bitmap is a collection of picture elements arranged in a pattern resembling a picture.

Note: You can create a bitmap file from scratch using any graphic editing package, such as Microsoft Paint. You can also scan your logo and save it as a bitmap file.

If you are working with live data (rather than sample data), the Logo Setup tab is blank the first time it is opened.

If you are working with sample data, the Logo Setup tab contains the ZSI logo the first time it is opened.

To Select a Logo

To select a logo, click Select. A dialog box opens so you can select the appropriate logo.

Select the correct path and name of your logo's bitmap file. Only those files with a .BMP extension appear. Click Select. The bitmap appears on the Logo Setup tab.

To Remove a Logo

To remove a logo from your system, click Remove on the Logo Setup tab.
When you remove a logo, you do not remove the bitmap file from your disk, only from the Sage HRMS database. You can select the file again any time you want.

**Set Up the Audit Trail**

The **Audit Trail Setup** tab of the Enterprise Setup page enables you to set up the audit trail.

The audit trail provides the ability to track changes a user makes to an action or page. This is an extremely useful tool for safeguarding Sage HRMS data. Auditing changes enables you to:

- Check who is making changes to the system and if the correct changes are being made
- Measure users’ performance
- Determine the number of changes users make and how often corrections are being made

The audit trail provides a before and after image of changes. It also keeps track of the date and time and the user who made the change.

The following standard reports are available to monitor the audit trail. To access the audit trail reports select **Reports > Audit Trail Reports** from the navigation pane.

- The Audit Trail Report by User provides a list of audit trail records sorted by the users who implemented the changes.
- The Audit Trail Report by Date provides a list of audit trail records sorted by the date on which the changes were made.
- The Audit Trail Report by File/Field provides a list of audit trail records sorted by the files and fields in which the changes were made.

**To Set Up the Audit Trail**

1. Click the **Audit Trail Setup** tab on the Enterprise Setup page.
2. In the **Enable Auditing** field, select **Yes** to turn the Audit Trail on and to enable the rest of the fields on the tab.

   **Note:** Turning the Audit Trail on or off does not affect the audit status of your selected files and fields. You can choose to audit any files and fields by setting their **Audit Status** to **Yes** or **No**. If you turn the Audit Trail on, the selected files and fields will be audited. If you turn the Audit Trail off, the files and fields will not be audited, but their audit status is maintained.

3. In the **Select File to Audit** field, scroll through the list of databases and click a database containing the fields you want to audit. As you select databases, the list of fields in the lower portion of the page changes to display the fields in the selected database.
4. If you want the system to audit the selected database file, select the **Enable File Audit** check box. Otherwise, clear the check box. The database file is preceded by a **Yes** (the file will be audited) or **No** (the file will not be audited), depending on whether you chose to audit the file.
5. The system provides three ways in which you can enable or disable auditing for the fields in the selected database file.
   - To enable auditing for all the fields in the selected database file, select Yes from the Audit All Fields in File drop-down list. A check appears in the Audit column next to each field in the file to indicate the audit status is Yes.
   - To disable auditing for all the fields in the selected database file, select No from the Audit All Fields in File drop-down list. The check is removed from the Audit column next to each field in the file to indicate the audit status is No.
   - To enable or disable auditing for individual fields in the selected database file, select or clear the check box in the Audit column next to the field for which you want to change the audit status.

   **Note:** You can set audit status to Yes for any editable field in a database. However, the system only audits the field if you have enabled auditing on the database file that contains the field. For example, you set your audit status to Yes for the Performance Review Rating field in the Employee Personnel database file. However, you did not enable file audit for the Employee Personnel database file. In this case, the system will not audit the Performance Review Rating field (or any field in the Employee Personnel file).

6. When you have finished your audit trail setup, click OK to save your changes and close the page, or click Apply to save your changes and remain on the page. The system proceeds to modify the audited fields list.

**Define User-Defined Code Table Titles**

The **User Defined Code Table Titles** tab enables you to define titles for your user-defined code tables.

**Setting Up Employers**

**Adding an Employer**

After setting up your enterprise, you are ready to start working with your employers. Setting up your employers is much easier if you gather all the required information beforehand.

You can have as many employers as you like. Each of these employers can have different specifications, such as different codes for jobs in the company, or different salary grade structures. When you set up your employers, you define different sets of specifications for each employer.

When adding an employer to your system, you must define some basic information, such as your employer’s name and address. The employer’s name is at the top of most pages and prints on most standard reports.

You can also define setup information for each Sage HRMS product you are using. The system provides the **Add Employer** action so you can add an employer at any time.
If your system includes Payroll

If your system is Sage U.S. Payroll or Canadian Payroll, you must first set up a SQL Database, and run database setup, and employer configuration before you add an employer with these steps. Go to Configuring Sage HRMS Payroll Link for setting up a new database, and then return here to add the payroll employer in Sage HRMS.

To Add an Employer

1. From the navigation pane, select Setup > System > Setup > Add Employer to open the Steps for Add Employer Task page.
2. Check the steps you want to complete. Depending on the products you installed, you must set up the employer for each product you are using. Complete each step now or schedule steps for yourself or another user to do later. Add Employer is a required step.
3. Click OK to start moving through the steps. The Employer Setup page opens.
4. Select the country in which the employer does business, enter U.S.
5. Enter the Employer Code that uniquely identifies the employer. You must enter three characters.
6. Enter the Employer Name. This field is required because the name appears at the top of pages and prints on most reports. You can also add the employer’s street address, city, state, zip, telephone number and fax number. The City and State fields are required.
7. Select the Pay Frequency used for the majority of the employees.
8. In the Normal Units field, enter the hours or units per pay period worked by most employees. For example, if employees are paid each week for a 40-hour week, enter 40.00. If employees are paid every two weeks for a 37.5-hour week, enter 75.00.
9. Select the employer’s main spoken language.

**Note:** The selections you make for steps 7 -10 are the defaults when you add new employees to this employer.

10. If you have Sage HRMS Payroll installed, the Payroll Database ID field appears. In this field, enter the ID for the Sage HRMS Payroll database you created and set up.
11. When you finish, click OK. The system adds the employer. If you selected to complete additional setup steps, the appropriate page (HR Setup, Attendance Setup or Training Setup) opens.
12. Log out of Sage HRMS by selecting File > Logout, then log back in to see the new employer in the Employer filter drop-down.

To Modify an Employer

1. From the navigation pane, select Setup > System > Setup > Modify Employer. If you have more than one employer defined, you must select the employer you want to modify.
2. Review and edit the information as necessary. You cannot change the employer’s **Country** or **Code**.

3. If you are using Sage HRMS Payroll, you must enter the ID for the payroll database you created in SQL Enterprise Manager, in the **Payroll Database ID** field.

4. Click **OK** to save your changes or **Cancel** to discard them.

**To Delete an Employer**

You can delete any employer added to your Sage HRMS system, for example, an employer you added by mistake.

The system provides two options to delete an employer:

- Delete the employer and employee information but maintain the security information and employer setup information.
- Delete all employer and employee information (including security options and employer setup information).

**Warning:** Deleting an employer permanently deletes all the related employee information. Before deleting an employer, back up the employer’s databases. If you need to restore information, you can restore the databases from the backup.

**Note:** If you are using Sage HRMS Payroll, employee information will only be deleted from Sage HRMS databases, not Payroll databases.

1. From the navigation pane, select **Setup > System > Setup > Delete Employer**.
2. Select the employer you want to delete and select the appropriate option for deleting the employer information.
3. Click **OK** to delete the employer. The system asks you to confirm the deletion.
4. Click **Yes** to delete the employer or **No** to cancel the process.

**Setting Up User Preferences**

Sage HRMS allows you to customize specific features to suit your needs. The system tracks these preferences for each user logging on to Sage HRMS.

For example, you can select which navigation pane group opens when you log on to Sage HRMS.

From the Main Menu, select **File > User Preferences** to open the User Preferences page.

The User Preferences page contains two tabs on which to enter information: **General Preferences** and **Setup Interviews**.
**General Preferences Tab**

Use the fields on the **General Preferences** tab to select your user preferences.

**Default View.** Select the navigation pane group or feature that you want to open in the workspace when you log on to Sage HRMS. By default, the Welcome to Sage HRMS page opens in the workspace after you log on to Sage HRMS. If you want to hide the Welcome to Sage HRMS page and display only the item you select in this field after you log on, select **Do not show me this page again** on the Welcome to Sage HRMS page.

**Employees Toolbar Default.** Select the employee-related page you want to automatically open when you log on to Sage HRMS.

**Note:** The Employees Toolbar Default list includes only the pages to which you have security access. If you select a default page that the system administrator might later restrict you from accessing, Sage HRMS assigns the next available page in the list as the default. If the restricted page was last in the list, Sage HRMS assigns the first page in the list as the default.

**Training Toolbar Default.** Select the training-related page you want to automatically open when you log on to Sage HRMS. This field does not display if you do not have Training installed.

**Note:** The **Training Toolbar Default** list includes only the pages to which you have security access. If you select a default page that the system administrator might later restrict you from accessing, Sage HRMS assigns the next available page in the list as the default. If the restricted page was last in the list, Sage HRMS assigns the first page in the list as the default.

**Default Employee Status Selection.** By default, the Employee Find function searches through all employees, regardless of their status, when you look for an employee. This is because, by default, all statuses are selected for the Default Employee Status Selection user preference.

You can change the default status selections by selecting or clearing the appropriate check boxes: **Active, LOA, Terminated, or Other.**

For example, if you select **Active** and clear all other status selections, the Employee Find only searches through employees with a status of **Active.** However, you can override the default Employee Status Selection by changing the status selections directly on the Employee Find dialog box.

**US Payroll Employer Default.** This drop-down list shows all US Payroll employers that have been set up in your system (with the assigned Payroll Database ID). The employer you select here is the one that will be used when non-employee level payroll pages are opened, regardless of whether the Employer Filter is set to Enterprise. For example, if you are working with payroll processes and your default US Payroll Employer is US/ABC, the data used in the payroll processes will be for employer US/ABC.

**Canadian Payroll Employer Default.** This drop-down list shows all Canadian Payroll employers that have been set up in your system (with the assigned Payroll Database ID). The employer you select here is the one that will be used when non-employee level payroll pages are opened, regardless of whether the
Employer Filter is set to Enterprise. For example, if you are working with payroll processes and your
default US Payroll Employer is Can/ABC, the data used in the payroll processes will be for employer
Can/ABC.

Automatically schedule tasks in Microsoft Outlook. When selected, all tasks listed in Scheduler will be
communicated through Microsoft Outlook to the assigned user.

**Note:** An e-mail address for the assigned user must be previously entered in User Security.

---

### Setup Interviews Tab

Enable or disable setup interviews at the user level. If you enable a Setup Interview, Sage HRMS asks you
if you want to use the setup interview to help you set up an insurance plan or savings plan.

On this tab, select if you want to enable the interview for the Insurance Plan Setup and the Savings Plan
Setup.

### Setting Up Code Tables

Sage HRMS uses codes to manage and store information in files. These codes provide abbreviated,
standard references to specific information. Sage HRMS stores these codes and their associated
descriptions in code tables.

A list of state and province abbreviations is an example of a code table. Instead of typing or re-entering a
state name (such as Mississippi) in a field, you can select the appropriate code (MS) from a list of
predefined codes contained in a code table. Instead of typing British Columbia, you can select the code
BC. Code tables contain one column for the code and a second column for the code description.

A drop-down list provides information for a field related to a code table. For instance, if a page contains a
field for the state, a drop-down list provides a list of state codes, such as MO, IA, and FL, from which you
can choose.

### Benefits of Using and Defining Code Tables

Code tables provide several advantages. Using code tables allows you to:

- **Customize information to meet your employer's needs.**

For example, you can define unique divisions, departments and locations specific to your employer.

- **Save time.**

When you enter information for hundreds of employees, it is much easier and more efficient to type or
select **RFT** for each employee rather than type **Regular Full Time**.

- **Ensure accuracy and consistency.**
Without a uniform coding scheme, a data entry clerk might enter a department code in several different ways (ENGDEPT, ENGRDEPT, ENG or ENGR) for several different employees. Even though the clerk describes the same department, Sage HRMS interprets the entries as four different pieces of information for four different departments. If the entries are inconsistent, Sage HRMS will not be able to calculate department totals accurately.

**Build Code Tables**

Most code tables in Sage HRMS are two-column tables containing codes in the left column and brief descriptions in the right column. However, some tables are more complex (benefit plans, for instance) and contain more information than can fit in two columns. The instructions for copying, adding, editing, and deleting codes are identical, whether you work with two-column or multi-column tables. Most code tables have recommended default values. You can add, edit, or delete values to suit your employer’s needs.

All of the predefined code tables in Sage HRMS are enterprise code tables. You can adjust these code tables to contain the codes most frequently used by the employers in your system. These codes then become the standard for your system.

When you initially set up a code table, the codes are blank. As long as the Codes area is blank, an individual employer uses the codes from the enterprise code table. As soon as you add a new code, the system recognizes you are creating a code table that no longer references the enterprise code table. To add a code for a specific employer from the list of enterprise codes, copy the enterprise code table to the employer code table and then add the unique code to the employer’s code table.

For example, if two of three employers in your system use the same codes, edit the enterprise code tables to accommodate the two employers. When you then set up codes for the two employers who share common codes, they automatically use the enterprise codes unless you create new codes in their code tables.

For the third employer who uses a slightly different set of codes, you can copy the enterprise code table and then make whatever minor changes are necessary to meet the third employer’s coding requirements. Therefore, you save time by not having to create a whole new set of codes from scratch, yet you are still able to customize the code table to the third employer’s specifications.

**Set Up Code Tables**

Sage HRMS allows you to quickly and easily add, edit, copy, and delete codes so you can meet each employer’s specific coding requirements. For instance, you might want to change a previously defined code to reflect a change in your organization.

**Notes:** After you save a code, the following fields are disabled.

- Benefit Rate Tables
- Benefit Savings Plans
- Attendance Plans
- Absence Reason Codes
- FMLA Event Reason Codes

**Working with Sage HRMS Code Tables**

Sage HRMS allows you to quickly and easily add, edit, copy, and delete codes so you can meet each employer’s specific coding requirements. For instance, you might want to change a previously defined code to reflect a change in your organization. The following sections describe how to work with Sage HRMS code tables.

**To Copy Code Tables**

1. From the navigation pane, select **Setup > Employees, Time Off, Payroll, or Training > Click the link for the type of codes you want to work with**. The code table you selected opens.
2. Select the employer with whom you want to work.
3. Click **Copy**. Only those employers with codes defined in the current table appear in the selection list. The employer with whom you are working does not appear in the list because you cannot copy codes from an employer to itself.
4. Highlight the enterprise or employer whose codes you want to copy and click **OK**. For most code tables, the Select Codes to Copy page opens. The **Available** list shows all the defined codes for that code table. The **Selected** list shows those codes you select.

   **Note:** When copying some codes you are first shown a dialog box informing you of the related codes which will be updated to correspond with those you are copying (see Job Codes below). Click **Yes** to continue or click **No** to return to the code table page.

5. From the **Available** list box, double-click the codes you want to copy. The selected codes appears in the right list box. If you want to remove a code from the **Selected** list, highlight it and click **Remove**.
6. Click **OK**. The system checks to see if the codes to be copied are the same as any which already exist for the employer receiving them. If there are any duplicates, Sage HRMS asks whether you want the old code to be overwritten with the new. Select **Yes** or **No**.
7. The new codes are copied to the employer with which you are working. To adapt the code table to this employer’s needs, you can add additional codes to the list.
8. Click the **Close** button after you finish making your changes.

**To Add Codes**

1. From the navigation pane, select **Setup > Employees, Time Off, Payroll, or Training > Click the link for the type of codes you want to use**. The code table you selected opens.
2. Select the employer with whom you want to work.
3. Click **Add**. The codes detail page opens.
4. Enter at least a code and description. Some code tables ask for additional information to be supplied for the added code. Other code tables contain a blank code described as **None Specified**. This
allows you to leave a field blank when you are entering information. To provide this option for your own code tables, include a blank code along with the description None Specified.

5. Click OK. Sage HRMS checks for duplicate codes and saves the changes if no duplicate exists. If a duplicate is found, the system prompts you to enter a different code.

To Edit Codes

1. From the navigation pane, select Setup > Employees, Time Off, Payroll, or Training > Click the link for the type of codes you want to work with. The code table you selected opens.
2. Select the employer with whom you want to work.
3. Highlight the code you want to edit and click More… The detail page for the code you selected opens.

   Notes: Codes that have been set up in the following code tables cannot be changed. If you need to change a code name, create a new code and delete the old one.
   
   • Benefit Rate Tables
   • Benefit Savings Plans
   • Attendance Plans
   • Absence Reason Codes
   • FMLA Event Reason Codes

4. Edit the information and click OK.

To Delete Codes

1. From the navigation pane, select Setup > Employees, Time Off, Payroll, or Training > Click the link for the type of codes you want to work with. The code table you selected opens.
2. Select the employer with whom you want to work.
3. Highlight the code you want to delete and click Delete. Sage HRMS prompts you to confirm the deletion. Also, deleting a code could affect history files and reports that contain the code.
4. Click Yes to delete the record, or click No to cancel the deletion.
5. Click the Close button when you finish.

Adding Codes from Details

You can also directly add codes to a code table when you are working with details pages. For every field that references a code table, Sage HRMS provides a drop-down list of codes. For example, on the Current Job page, the Job Code field accesses the Job Codes table.
Sage HRMS provides an option that enables you to add a new code while you are entering information on the page. When working with Sage HRMS, you can add codes from pages for all Sage HRMS code tables except for the Benefit Insurance Plans, Benefit Savings Plans, and Benefit Rate Tables. You must access these code tables in Rules to work with them.

**To Add a Code from a Detail**

For more information about using drop-down lists, see Using pages.

1. Open the drop-down list for the field that references the code table you want to update.
2. Scroll to the bottom of the list and select **Add New Code**. A page opens so you can add a new code.
3. Enter the information for the new code and click **OK**. Sage HRMS adds the code to the list and selects the new code for the field.

**Setting Up Security**

**Set Up Page Security**

When setting up security for your system, you can define the access rights for specific pages. Different users might have different kinds of security access to specific pages. When you find an employee from a page, the only employees who appear are those you have permission to view.

For example, there are two security rules defined for a user named Joan Martin:

- Martin can view the Current Pay pages for employees in employer ABC and employer DEF.
- Martin can view the Wellness pages for employees only in employer ABC.

When Joan Martin is working on the Current Pay page and wants to find an employee, she can see all employees in ABC and DEF. However, if she is working on the Wellness page and wants to find an employee, she is only able to see the employees in ABC. She cannot view or work on the Wellness page of any employee in employer DEF because the system denies her access to that information.

Sage HRMS has an extensive, flexible, and easy-to-use security system to protect your data. You have complete precision in restricting access because the security system breaks down functions within Sage HRMS by employer, product, activity, task, step, and groups of employees.

If you are the system administrator or the sole user of your system, you can set up Sage HRMS to have access to all security options. Usually an organization’s system administrator sets up and changes security privileges for all Sage HRMS system users. For instance, as the system administrator, you can allow a user access to all employee information except current pay data. Or, you can give a user the ability to enter only demographic information for new employees.

As a normal user, you are assigned a user ID and password which establish your ability to view, change, and process data. In this capacity, you are limited to changing your own password.
Security Concepts

Each person accessing Sage HRMS has a user ID, and each user ID is associated with a password. You probably want to establish the same level of security access for a group of users (not just one user), and the security system lets you create security groups and establish different access rights for each group.

Group Security

A security group is a collection of one or more users with the same access rights. Each security group has a name (assigned when you create the group), and each user (other than the system administrator) is a member of a group. As the system administrator, you assign access rights to the group and not to an individual user. The group a user belongs to determines the access rights of an individual user. As the system administrator, you automatically have access to all functions.

Note: The sole purpose of the security system is to restrict access to various areas within Sage HRMS. The system does not keep track of failed attempts to access system features or report on the functions accessed by users.

User Security

Each security group contains one or more users assigned to the group. You provide a user name, ID, and password for each user. Before beginning to assign users to groups and access rights, collect the IDs, names, and passwords of the employees.

Before You Begin

Prior to setting up access rights for your users, you must set up several components in your system.

1. Set up the enterprise.
2. Add and set up your employers.
3. Design any custom pages you want to use with your Sage HRMS products.

Establish Access Rights

Establish access rights if you want to restrict any portion of the system to one or more users. However, it might not be necessary for you to set up security for your system. Consider the following two situations, neither of which require any security setup.

- You are the system administrator and you are the only one using Sage HRMS. You do not need to set up security. When you sign on using MASTER as the user ID, you automatically have access to the entire system.
- You want all users to have unrestricted access to the system. Rather than setting up any security, have each user log on using MASTER as the user ID. Each user can access the entire system.

Note: If you receive updates to Sage HRMS that include new features, the MASTER user ID is automatically updated and always has access to all features. For any additional security groups you
created previously, you must update the security group information to provide access to the new features. This provides a safeguard so you can always decide who can access the new features.

This next situation requires security setup. You are the system administrator and install the following products on your system: Time Off, Sage HRMS, and Training. You want to set up two users for the employer ZSI.

The first user can only enter new employees into the system. The second user has access to the entire system but cannot view or update certain fields. You must:

- Set Up a Security Group for User #1
- Set Up a Security Group for User #2
- Set Up Users

If you must further restrict your users and disallow access rights to specific employee records, refer to Product Group Filters.

**Set Group Security**

A security group is a collection of one or more users with the same access rights. Each security group has a name (assigned when you create the group), and each user (other than the system administrator) is a member of a group. As the system administrator, you assign access rights to the group and not to an individual user. The group a user belongs to determines the access rights of an individual user. As the system administrator, you automatically have access to all functions.

**Note:** The sole purpose of the security system is to restrict access to various areas within Sage HRMS. The system does not keep track of failed attempts to access system features or report on the functions accessed by users.

**Security Levels**

When you (as the system administrator) set up security for a group, you can establish access rights at the following levels:

- Employer
- Product
- Activity
- Task
- Step
- Field

The employers include all the employers you set up in your enterprise.
You assign access rights to products depending on the products you have installed and set up on your Sage HRMS system. The System is treated as a separate product to help organize tasks.

**Note:** You must first select N/A for the employer before you can select System as a product.

The activities you can assign access rights to include: Action, Analysis, Detail, Process, Report, and Rule. There is a different set of tasks for each activity and a different set of steps for each task.

You can also set view and update rights for groups of specific fields in an employee’s record, such as address and phone, salary, or EEO information.

Setting the Ad Hoc Reporting Security Level enables you to establish an access level for SAP Crystal Reports® and Secure Query. This access level determines which fields in your system databases can be accessed by the security group’s users whenever they use SAP Crystal Reports® or Secure Query.

**To Add a Group**

2. To add a group, click Add. In the New Group Name field enter the name of the group you are adding (up to 20 letters and numbers). Click OK.
3. Click Yes to verify you are adding the group. The program builds the access rights structure for this group. The Security Group page opens.
4. Initially a new group has no access rights. Accordingly, the page has no entries in any of the columns. The Modify button at the bottom of the Employer column is enabled, indicating you can modify access rights at the employer level. All other Modify buttons are disabled.
5. Click Modify. The Employer Selection dialog box opens. The Allow Access column for each employer is initially set to No.

   **Note:** The Employer list also contains the N/A option. Change the access to Yes for N/A in order to access System in the Product column on the Security Group page.

6. Double-click the employer to change the access to Yes.

   **Warning:** If you allow a security group to access Group Security under System Rules, users in that group can change their own security access rights. They can let their security group (and any other security group) access all features, which is the same as no security at all. We recommend limiting the access rights of all security groups to only one security feature: Change Password. The MASTER user ID has access to all Sage HRMS system features.

7. Click OK. The system rebuilds the information on the Security Group page.
8. Click Modify in the Product column to open the Product Selection dialog box. The Allow Access column for each product is initially set to Yes.

   **Note:** If you have U.S. Payroll and Canadian Payroll installed and want to restrict access to either U.S. Payroll or Canadian Payroll, you must set the security in two steps. Let’s say you want to...
restrict access so that users will only be able to access Canadian Payroll. In the Product Selection dialog box, set the Allow Access to Yes for Canadian Payroll. Then set the Allow Access to No for Payroll (which is U.S. Payroll). It is imperative that you set the access correctly for both U.S. Payroll and Canadian Payroll.

9. Double-click the products to change the access to No.
10. Click OK to return to the Security Group page.
11. Select the product for which you are setting security. All activities, tasks, and steps appear in the related columns.
12. Click Modify in the Activity column to open the Activity Selection dialog box. The Allow Access column for each activity is initially set to Yes.
13. Double-click the activity to change the access to No.
14. Click OK to return to the Security Group page.
15. Select the activity for which you are setting security. The tasks and steps appear in the related columns.
16. Click Modify in the Task column to open the Task Selection dialog box. The Allow Access column for each task is initially set to Yes.
17. Double-click the task to change the access to No.
18. Click OK to return to the Security Group page.

**Note:** If a user has a task assigned on their Scheduler, the security system does not allow you to restrict that user’s access to that task. Therefore, because the user is a member of a security group, the security system does not allow you to restrict that group’s access to that task.

19. Select the task for which you are setting security.
20. Click Modify in the Step column to open the Step Selection dialog box. The Allow Access column for each step is initially set to Yes.
21. Double-click the step to change the access to No. If you selected Detail in the Activity column, double-click the steps to change access to View, Update, or None.
22. Click OK to return to the Security Group page.
23. Repeat steps 4 through 22 to set access rights for another employer, product, activity, task, or step.
24. Click OK to return to the Security Groups dialog box.

**To Edit a Group**

2. Select the group with whom you want to work.
4. Edit information as necessary.
5. Click OK.
To Delete a Group

2. Highlight the group you want to delete and click Delete.
3. Confirm the deletion.
   - If there are no users in the group, the system deletes the group.
   - If there are users in the group, the system alerts you and asks you to confirm the deletion again. If you select Yes, the group and any users within the group are deleted.
   - If a user within the group has tasks scheduled on their Organizer, the system alerts you and does not allow you to delete the group. Click OK to display the user’s task schedule.

   **Note:** Before deleting the group, remove the scheduled tasks from the user’s Organizer. Delete the user or assign the user to another security group. Repeat the above procedure to delete the group.

4. Review the list of tasks. To print the tasks for easy reference, click Print. Click the Close button to return to the Group Security dialog box.

Each security group contains one or more users assigned to the group. You provide a user name, ID, and password for each user. Before beginning to assign users to groups and access rights, collect the IDs, names, and passwords of the employees.

To Add a User

1. From the navigation pane, select Setup > System > Security > User Security.
2. Click Add. The User Security dialog box opens.
3. Enter up to ten characters for the User ID. You can enter the user’s initials, the first name, and the first letter of the last name or any other suitable abbreviation. The system converts all characters to upper-case.
4. Enter up to 25 numbers or characters for a user name. It can be any combination of upper-case and lower-case letters and numbers. The user name should contain the user’s full first and last name. It is used in the scheduler for task assignments.
5. Enter up to eight characters for the user’s password. For security reasons, you will not see the password that you enter. Only asterisks appear in the field. The system automatically converts all characters to upper-case.
6. Enter up to 64 characters for the e-mail address assigned to the user.
7. From the Group drop-down list, select the group to which you are assigning the user.
   - If you are also using Sage HRMS Link, the Allow Access to Sage HRMS Link radio buttons are enabled. If you do not want this user to have access to Sage HRMS Link, click No. Otherwise, click Yes.
8. Click OK. The Password Verification dialog box opens.
9. Enter the user's password again for verification and click OK. The system records the password and returns to the User Security page.
10. Repeat steps 2 through 10 to set up additional users. When you finish, click the Close button to close the Security Groups dialog box.

To Edit a User
1. From the navigation pane, select Setup > System > Security > User Security.
2. Select the user with whom you want to work.
3. Click More…. The User Security dialog box opens.
4. Edit information as necessary.

**Note:** If you are editing a user and changing the security group to restrict the user’s access, make sure you reassign the tasks this user is no longer able to perform due to restricted access. For information about assigning tasks, see Use the Scheduler.

5. Click OK.

To Delete a User
1. From the navigation pane, select Setup > System > Security > User Security.
2. Select the user you want to delete.
3. Click Delete. If the user is not scheduled to perform any tasks, confirm the deletion. If the user has tasks scheduled on their Organizer, the system alerts you and does not allow you to delete the user. Click OK to display the user’s task schedule.
4. Review the list of tasks. To print the tasks for easy reference, click Print. Click the Close button to return to the User Security dialog box.

Before deleting the user, remove the scheduled tasks from the user’s Organizer. After deleting the tasks, repeat the above procedure to delete the user.

**Set Field Level Security**

Field Level Security lets you limit access to certain categories of data for a specific employer. It is available for SAP Crystal Reports®, Secure Query, and some detail pages. Field Level Security is set at the group level, and all the users you assign to the group must adhere to the type of security you select for each category.

When you initially add a security group, the group does not have access to view or update fields containing information in the following categories: Address/Phone, Salary, and EEO. You can provide access to view or update these fields through field level security.

**Note:** Field security is not available for standard reports. If you need to prevent certain employees from viewing specific fields on standard reports, consider removing the entire report from the menus to which the employees have access (use group security to remove reports from menus).
Field Level Access

Fields in the **Address/Phone** category pertain to home, not business information. This information is located on the Demographics page and includes the telephone number, street address, city, state and zip code, county, and country.

Fields in the **Salary** category are found on the Payroll Status page in Sage HRMS Payroll and the Current Pay Status page in Sage HRMS. Information includes the:

- unit pay rate
- pay period salary
- hours/units worked per pay period
- pay frequency
- annual pay
- shift premium
- last pay change amount or percent bonus amount (if applicable)
- salary grade
- frequency of the employee’s contribution to savings plans

The **EEO** category controls access to EEO information and includes marital status, ethnic origin, gender and disability.

**Note:** Not all these fields are contained in the Sage HRMS system databases. Therefore, for some fields, you can only set field level security if you selected products other than the Sage HRMS system.

Set Field Level Security

1. From the navigation pane, select **Setup > System > Security > Group Security**.
2. Select the group with whom you want to work.
4. Click the **Field Level Security** tab.
5. Select an employer from the **Employer Selection** list.
6. For each applicable category, select the appropriate access level by selecting one of the options listed in the following table. Access rights to fields containing Address/Phone, Salary, or EEO information initially default to **Not View**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not View</td>
<td>Restricts users from viewing and updating the data. When users access areas of the system containing these fields, the word <strong>Hidden</strong> is displayed.</td>
</tr>
</tbody>
</table>

**Note:** If a user cannot view a field which appears on a report, it means the user is
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>also restricted from generating that report.</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td>Enables users to view the data but restricts them from updating it.</td>
</tr>
<tr>
<td>Update</td>
<td>Enables users to view and update the data.</td>
</tr>
</tbody>
</table>

7. Click **Apply** to save your changes. You can then select another employer and set field security for that employer.

8. When you are finished setting field security for employers, you can move to another tab on the Security Group page or click **OK** to close the page.

**Set Product Group Filters**

In addition to restricting access to specific fields with the field level security function, you can select specific employees you want the security group users to access. For example, if you want users of a security group to access only employees whose original hire date is prior to June 1, 2012, the system lets you set a product group filter allowing access to only employees fitting that criteria.

**To Set a Product Group Filter**

To tell the system which database records you want a security group’s users to be able to access, build an expression on the **Product Group Filters** tab of the Security Group page.

1. From the navigation pane, select **Setup > System > Security > Group Security**.
2. Select the group you want to work with.
3. Click **More**... The Security Group page opens.
4. Click the **Product Group Filters** tab.
5. Select the product you are using for this group filter.

   **Note:** If Payroll is included with your system, any product group filters you set for HR automatically apply to Payroll. Therefore, if you select Payroll as your Product Selection, the Fields listed are disabled and cannot be specifically selected for Payroll.

6. Build the expression. An expression consists of a field, relationship, and value. The following sections step you through building an expression.

**Field**

The **Fields** list contains every field in the master file corresponding to your product. For example, for Sage HRMS, the list includes every field in the Employee Personnel file.

Use the scroll bar in the **Fields** list to locate the field and double-click to select it. The field appears in the Expression box.
Relationship
The Operators list contains the mathematical operators signifying the relationship in our expression. Operators specify a relationship between the field and the value. Refer to the following Operators table to see the valid operators and their descriptions.

Use the scroll bar to locate the operator and double-click to select it. The operator is added to the expression in the Expression box.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>AND</td>
<td>And - for compound expressions</td>
</tr>
<tr>
<td>OR</td>
<td>Or - for compound expressions</td>
</tr>
<tr>
<td>+</td>
<td>Add - used when computing a value</td>
</tr>
<tr>
<td>-</td>
<td>Subtract - used when computing a value</td>
</tr>
<tr>
<td>*</td>
<td>Multiply - used when computing a value</td>
</tr>
<tr>
<td>/</td>
<td>Divide - used when computing a value</td>
</tr>
</tbody>
</table>

Value
Enter the expression’s value directly into the expression. For example, you want users of a security group to access only employees whose original hire date is prior to June 1, 2002. Place your cursor to the right of the operator. Enter the date in numeric form and enclose it in braces. Your expression reads:

P_ORIGHIRE < {06/01/2002}

The expression is complete.

Note: The maximum length of an expression is 200 characters.
Verify the Expression

Click Verify to make sure your expression is built in a format the system can interpret. The system indicates if the expression is valid. If it is not, determine your error, place your cursor in the Expression box, and then correct the error. Use the Backspace and Delete keys to clear the expression as necessary.

When your expression is correct, click Apply to save your changes and remain on the Security Group page, or click OK to save your changes and close the Security Group page.

Note: You can also build a compound expression. For example, if you want to limit access to employees whose original hire date is between April 1, 2002 and June 1, 2002, your expression reads:

\[ P\_ORIGHIRE > \{03/31/2002\} \text{ AND } P\_ORIGHIRE < \{06/02/2002\} \]

Tip: The format of expressions is consistent with the Xbase programming language standards, except the AND and OR operators do not need to be enclosed with periods. If you are familiar with formatting expressions, you might find it easier and faster to enter the complete expression simply by clicking in the expression box and typing the entire expression.

To Edit or Delete a Product Group Filter

2. Select the group with whom you want to work.
4. Click the Product Group Filters tab.
5. Select the product for which you want to edit or delete the group filter.
6. Place your cursor in the Expression box and edit the expression as needed. If you want to delete the filter altogether, use the Backspace and Delete keys to clear the entire expression.
7. Click Apply to save your changes and remain on the Security Group page, or click OK to save your changes and close the Security Group page.

Setting Up Ad Hoc Reporting Security

SAP Crystal Reports® and Secure Query enable you to design and generate your own queries and reports using system database files. Any user who has access to SAP Crystal Reports® or Secure Query can view any field without restrictions. Ad Hoc Reporting Security lets you restrict the database files and fields available to a security group using SAP Crystal Reports® or Secure Query.

When you set up security for a group, you can assign an Ad Hoc Reporting Security Level to each security group. To further restrict access to the user, Ad Hoc Reporting Security lets you assign an access level to each field included in your databases.

Note: The access levels you assign here affect access only in SAP Crystal Reports® and Secure Query and do not impact the rest of the system.
How Access Levels Work

Before changing access levels, you need to understand how access levels work. This section illustrates why you would change access levels for your database fields.

Each field in each database file contained in your Sage HRMS system is listed on this page. The fields are grouped alphabetically by database file. Each line item displays the database file name, the field description, and the field’s access level. There are nine access levels (one through nine). Initially, all fields are set to the same access level, one.

Allow All Users Access to All Fields

Working in conjunction with Ad Hoc Reporting Security is the Ad Hoc Reporting Security Level feature on the Security Group page.

Initially, when you set up security for a group, the Ad Hoc Reporting Security Level is set to one, just as each field in Ad Hoc Reporting Security is set to one. This means the group’s users can access all the fields set to one.

If you want all users to have access to all fields when they generate reports using SAP Crystal Reports or Secure Query, maintain one as your Ad Hoc Reporting Security Level and you do not have to change anything in Ad Hoc Reporting Security.

Note: The MASTER user ID has an Ad Hoc Reporting Security Level of nine and can access all fields.

Restrict User Access to Fields

To restrict a user’s access to specific fields in a database, change the field’s access level as well as the Ad Hoc Reporting Security Level for the user’s security group. The combination of a group’s Ad Hoc Reporting Security Level and a field’s access level set in Ad Hoc Reporting Security determines if the field is accessible by a user. Consider the following example:

We have two security groups and one user in each group. The first group, Data Entry, has a user called DE. The second group, Pay Manager, has a user called PM. Except for one restriction, we want these users to have the same capabilities generating custom reports in SAP Crystal Reports® and Secure Query. However, we do not want DE to have the capabilities to generate a custom report containing the Earnings/Deductions Code field.

In Ad Hoc Reporting Security, we change the access level for the Earnings/Deductions code to five. We leave the Ad Hoc Reporting Security Level at one for the Data Entry group, and change it to five for the Pay Manager group.

Now, when DE (a member of the Data Entry group) accesses SAP Crystal Reports® or Secure Query, DE cannot create a report containing the Earnings/Deductions Code field. DE’s security group is set at access level one, which prohibits DE from accessing any fields in Sage HRMS with an access level higher than one.

In order to access the Earnings/Deductions Code field, a user’s group must have an Ad Hoc Reporting ADA Security Level of at least five. Consequently, user PM can access this field. In addition, if we set the
Ad Hoc Reporting Security access level to six for the **Earnings/Deductions Code** field, even PM is unable to use that field in SAP Crystal Reports® or Secure Query, because PM's access level is only five.

**To Set Access Levels**

The Ad Hoc Reporting Security page has the means to quickly and easily change access levels for fields in your databases. Before setting access levels, determine to which fields you want to restrict access.

You can set the access level of all fields in all database files, all fields within one database file or one field at a time. The database files and the fields within the files are listed alphabetically. Use the product’s Data Dictionary to help you locate a specific field within a database file.

1. From the navigation pane, select **Setup > System > Security > Ad Hoc Reporting Security**.
2. Set the access levels as necessary.
3. To set all fields in all database files, enter a number from one to nine in the **All Fields** number box at the top of the page. You can also use the arrows to set the level. All fields change to the access level you set.
4. To set all fields within one database file, locate the database file and click any line item within the file. Enter a number from one to nine in the **Fields for Selected File** number box at the top of the panel. You can also use the arrows to set the level. All fields within the selected database file change to your selected access level.
5. To set one field at a time, use the scroll bar to locate the field. To set the access level, click the line item to select it and enter a number from one to nine.

**Tip:** Set the access level for all fields in all database files first. If you want a different access level for specific files, set them next. Remember, setting an access level for all fields overrides any previously established field settings.

**Set a Group’s Ad Hoc Reporting Security Level**

A security group’s access to SAP Crystal Reports® and Secure Query works in conjunction with setting Ad Hoc Reporting Security. When you set security for SAP Crystal Reports® and Secure Query, you can define access rights at the field level, and each field in your system is assigned its own level of security.

When you set up security for a group using **Setup > System > Security > Group Security** from the navigation pane, you establish an access level for SAP Crystal Reports® and Secure Query. This access level determines which fields in your system databases are able to be accessed by the security group’s users whenever they use SAP Crystal Reports® or Secure Query.

For example, if you set the Ad Hoc Reporting Security Level to one, users can only access database fields with an access level of one. If you set the Ad Hoc Reporting Security Level to two, users can access database fields whose access levels are one or two. Following this logic, if you set the Ad Hoc Reporting Security Level to nine, users can access all database fields and have access to levels one through nine.
To Set a Group’s Ad Hoc Reporting Security Level

2. Double-click the group you want to work with to open the Security Groups page.
4. If necessary, set a product group filter and field level security.
5. Change the Ad Hoc Reporting Security Level by entering a number from one to nine or use the arrows to change the number.
6. Click OK to save your changes and return to the Security Groups dialog box.
7. Click the Close button to close the Security Groups dialog box.

Changing a Password

As system administrator, you might want to change a user’s password. Individual users can also change their own passwords unless it is restricted by their security.

If you are the system administrator, log on to the system as MASTER, and change the password of a system user by accessing the User Security dialog box. See the section Setting User Security.

If you are a non-administrator, follow the next set of instructions.

To Change a Password

1. From the navigation pane, select Setup > System > Maintenance > Change Password.
2. Enter up to ten characters (this includes alphanumeric upper and lower case characters, as well as special characters).
   
   Note: Spaces are not permitted when creating or changing a password.

3. Click OK. To help maintain security, the password does not appear on the page as it is entered.
4. Enter your new password again for verification. Click OK. The system records your new password.
5. Click OK.

Quick Launch Toolbar Security

You can establish or remove access rights to any application, including the Microsoft Office applications, on the Quick Launch toolbar.

To Set Up Quick Launch Toolbar Security

2. Select the security group with whom you want to work.
4. Select N/A under the Employer, System under the Product, Quick Launch under the Activity, and the application to restrict access to under Task.
5. Click Modify in the Step column to open the Step Selection dialog box. The Allow Access column for each application is initially set to Yes.
6. Double-click the applications to change the access to No.
7. Click OK to return to the Security Group page.